# Table of Content

## Prologue

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>I.</td>
<td>Revision History</td>
</tr>
<tr>
<td>II.</td>
<td>Contact Addresses</td>
</tr>
<tr>
<td>III.</td>
<td>Trademarks</td>
</tr>
<tr>
<td>IV.</td>
<td>Intended Use</td>
</tr>
<tr>
<td>V.</td>
<td>Software License Agreement</td>
</tr>
<tr>
<td>VI.</td>
<td>Preamble</td>
</tr>
<tr>
<td>VII.</td>
<td>Usage of the Instrument Software Manual</td>
</tr>
<tr>
<td>VIII.</td>
<td>Conventions Used in this Manual</td>
</tr>
</tbody>
</table>

## A. About RTCA Software

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>System Requirements and RTCA Software Installation</td>
</tr>
<tr>
<td>1.1</td>
<td>System Requirements</td>
</tr>
<tr>
<td>1.2</td>
<td>Install RTCA Software</td>
</tr>
<tr>
<td>1.2.1</td>
<td>Install RTCA Software</td>
</tr>
<tr>
<td>1.2.2</td>
<td>Launch RTCA Software</td>
</tr>
<tr>
<td>1.3</td>
<td>Uninstall RTCA Software</td>
</tr>
<tr>
<td>1.4</td>
<td>User Management</td>
</tr>
<tr>
<td>2.</td>
<td>Entering SP, MP, DP or TP Real-Time Mode Automatically</td>
</tr>
<tr>
<td>3.</td>
<td>Entering SP, MP, DP or TP Offline Mode</td>
</tr>
<tr>
<td>4.</td>
<td>RTCA Software Command Line Parameters</td>
</tr>
<tr>
<td>5.</td>
<td>How to Use this Software Manual</td>
</tr>
</tbody>
</table>

## B. Software Function

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>Overview of the RTCA Software</td>
</tr>
<tr>
<td>1.1</td>
<td>Software Functions</td>
</tr>
<tr>
<td>1.1.1</td>
<td>RTCA Software Functions Required for Running Experiments</td>
</tr>
<tr>
<td>1.1.2</td>
<td>RTCA Software Functions Required for Monitoring Experiments</td>
</tr>
<tr>
<td>2.</td>
<td>Starting an Experiment</td>
</tr>
<tr>
<td>2.1</td>
<td>Launch the RTCA Software</td>
</tr>
<tr>
<td>2.2</td>
<td>Check the Software Version</td>
</tr>
<tr>
<td>2.3</td>
<td>Menus of Main Window and Plate Window</td>
</tr>
<tr>
<td>2.3.1</td>
<td>Main Menu</td>
</tr>
<tr>
<td>2.3.2</td>
<td>Plate Window Menu</td>
</tr>
<tr>
<td>2.4</td>
<td>Experiment Record</td>
</tr>
<tr>
<td>2.5</td>
<td>Text Boxes on Exp Notes Page</td>
</tr>
<tr>
<td>2.6</td>
<td>Example of a Completed Exp Notes Page</td>
</tr>
<tr>
<td>3.</td>
<td>Design an Experiment</td>
</tr>
<tr>
<td>3.1</td>
<td>Experiment Layout</td>
</tr>
<tr>
<td>3.2</td>
<td>Add Experimental Information</td>
</tr>
<tr>
<td>3.3</td>
<td>Enable Wells</td>
</tr>
<tr>
<td>3.4</td>
<td>Information Boxes</td>
</tr>
<tr>
<td>3.5</td>
<td>Example of a Completed Layout Page</td>
</tr>
<tr>
<td>3.6</td>
<td>Example of Dilution Factor and Dilution Repetition</td>
</tr>
<tr>
<td>3.7</td>
<td>Copy/Paste Layout Settings</td>
</tr>
<tr>
<td>B</td>
<td>Software Function</td>
</tr>
<tr>
<td>---</td>
<td>------------------</td>
</tr>
<tr>
<td>4.</td>
<td><strong>Experiment Schedule</strong></td>
</tr>
<tr>
<td>4.1</td>
<td>Add Steps and Set Measurement Parameters</td>
</tr>
<tr>
<td>4.1.1</td>
<td>Schedule Parameter Setting</td>
</tr>
<tr>
<td>4.1.2</td>
<td>Change the Preset Schedule of a Step</td>
</tr>
<tr>
<td>4.1.3</td>
<td>Total Time</td>
</tr>
<tr>
<td>4.2</td>
<td>Delete Steps</td>
</tr>
<tr>
<td>4.3</td>
<td>Insert Steps</td>
</tr>
<tr>
<td>4.4</td>
<td>Set up a Background Step</td>
</tr>
<tr>
<td>4.5</td>
<td>Saving Set-up(s)</td>
</tr>
<tr>
<td>4.6</td>
<td>Opening a Template (Clone Settings)</td>
</tr>
<tr>
<td>5.</td>
<td><strong>Start an Experiment</strong></td>
</tr>
<tr>
<td>5.1</td>
<td>Scan Plate</td>
</tr>
<tr>
<td>5.1.1</td>
<td>Manual Scan Plate</td>
</tr>
<tr>
<td>5.1.2</td>
<td>Automatic Scan Plate</td>
</tr>
<tr>
<td>5.1.3</td>
<td>Check System</td>
</tr>
<tr>
<td>5.2</td>
<td>Example of Results from Scan Plate</td>
</tr>
<tr>
<td>5.3</td>
<td>How to Handle Connection Issues</td>
</tr>
<tr>
<td>5.4</td>
<td>Start Measurement</td>
</tr>
<tr>
<td>5.5</td>
<td>Continue the Experiment</td>
</tr>
<tr>
<td>5.6</td>
<td>Pause the Experiment</td>
</tr>
<tr>
<td>5.7</td>
<td>Start a Step</td>
</tr>
<tr>
<td>5.8</td>
<td>Abort a Step</td>
</tr>
<tr>
<td>5.9</td>
<td>Monitoring the Current Experiment Status</td>
</tr>
<tr>
<td>6.</td>
<td><strong>Monitor an Experiment in Cell Index Page</strong></td>
</tr>
<tr>
<td>6.1</td>
<td>Cell Index Table</td>
</tr>
<tr>
<td>6.2</td>
<td>Scan Plate Data and Background Data Table</td>
</tr>
<tr>
<td>6.3</td>
<td>Copy Cell Index Data and Raw Data</td>
</tr>
<tr>
<td>7.</td>
<td><strong>Plot Experiment Data</strong></td>
</tr>
<tr>
<td>7.1</td>
<td>Plot Selection</td>
</tr>
<tr>
<td>7.2</td>
<td>Curve Options</td>
</tr>
<tr>
<td>7.3</td>
<td>Scale</td>
</tr>
<tr>
<td>7.4</td>
<td>Curve Color Selections</td>
</tr>
<tr>
<td>7.5</td>
<td>Other Function Buttons</td>
</tr>
<tr>
<td>7.6</td>
<td>Well Map</td>
</tr>
<tr>
<td>7.7</td>
<td>Example of Adding Wells to the Chart</td>
</tr>
<tr>
<td>7.8</td>
<td>Example of the Average Function</td>
</tr>
<tr>
<td>7.9</td>
<td>Example of the Log Scale</td>
</tr>
<tr>
<td>7.10</td>
<td>Zoom In/Zoom Out</td>
</tr>
<tr>
<td>7.11</td>
<td>Curve Repair Function</td>
</tr>
<tr>
<td>7.11.1</td>
<td>Shift of Curves</td>
</tr>
<tr>
<td>7.11.2</td>
<td>Line Fit</td>
</tr>
<tr>
<td>7.12</td>
<td>Baseline Cell Index</td>
</tr>
<tr>
<td>7.13</td>
<td>Normalized Cell Index</td>
</tr>
<tr>
<td>7.14</td>
<td>Delta Cell Index</td>
</tr>
<tr>
<td>7.15</td>
<td>Settings for Data Analysis</td>
</tr>
<tr>
<td>8.</td>
<td><strong>Copying Experiment Data</strong></td>
</tr>
<tr>
<td>8.1</td>
<td>Copy Experiment Data to Microsoft Excel</td>
</tr>
<tr>
<td>8.2</td>
<td>Copy Graphic Charts or Data on Charts</td>
</tr>
<tr>
<td>8.3</td>
<td>Example of a Right-Click Menu</td>
</tr>
<tr>
<td>B</td>
<td>Software Function</td>
</tr>
<tr>
<td>---</td>
<td>-------------------</td>
</tr>
<tr>
<td>9.</td>
<td>Well Graph</td>
</tr>
<tr>
<td>9.1</td>
<td>User Interface</td>
</tr>
<tr>
<td>9.2</td>
<td>Well Graph Display</td>
</tr>
<tr>
<td>9.3</td>
<td>Zoom Area</td>
</tr>
<tr>
<td>9.4</td>
<td>Graph Setting</td>
</tr>
<tr>
<td>9.5</td>
<td>Summary</td>
</tr>
<tr>
<td>10.</td>
<td>Data Analysis</td>
</tr>
<tr>
<td>10.1</td>
<td>Tool Bar Button Definitions</td>
</tr>
<tr>
<td>10.1.1</td>
<td>Draw Curve, Add Curve and Clear Curve</td>
</tr>
<tr>
<td>10.1.2</td>
<td>Copy Page, Copy Chart and Copy Data on Chart</td>
</tr>
<tr>
<td>10.2</td>
<td>Data Analysis Functions</td>
</tr>
<tr>
<td>10.2.1</td>
<td>Experimental Data for Analysis</td>
</tr>
<tr>
<td>10.2.2</td>
<td>Well Selection for Analysis</td>
</tr>
<tr>
<td>10.2.3</td>
<td>An Example of Data Analysis: Dose-Response Curve (DRC) at a Time Point</td>
</tr>
<tr>
<td>10.2.4</td>
<td>Curve Types and Curve-Fit Formula</td>
</tr>
<tr>
<td>10.2.5</td>
<td>Compare Dose-Response Curves and Corresponding EC_{50}/IC_{50} Values for Selected Wells at Different Time Points</td>
</tr>
<tr>
<td>10.2.6</td>
<td>Compare Dose-Response Curves and Corresponding EC_{50}/IC_{50} Values for Different Wells at the Same Time Point</td>
</tr>
<tr>
<td>10.2.7</td>
<td>Compare Cell Index Slopes (or Cell Index Doubling Times)</td>
</tr>
<tr>
<td>11.</td>
<td>Message Page</td>
</tr>
<tr>
<td>11.1</td>
<td>Warning Message Sign</td>
</tr>
<tr>
<td>11.2</td>
<td>Error Message Sign</td>
</tr>
<tr>
<td>12.</td>
<td>Audit Trail Page</td>
</tr>
<tr>
<td>13.</td>
<td>Experiment Reports</td>
</tr>
<tr>
<td>13.1</td>
<td>Create a Problem Report</td>
</tr>
<tr>
<td>13.2</td>
<td>Create an Excel Format Report</td>
</tr>
<tr>
<td>14.</td>
<td>RTCA Software Functions Unique To The RTCA MP Instrument</td>
</tr>
<tr>
<td>14.1</td>
<td>MP User Graphic Interface</td>
</tr>
<tr>
<td>14.2</td>
<td>The Major Differences of RTCA SP and RTCA MP Instruments</td>
</tr>
<tr>
<td>14.3</td>
<td>Overview of Functions and Controls Unique to the RTCA MP Instrument</td>
</tr>
<tr>
<td>14.4</td>
<td>Launch RTCA MP Software</td>
</tr>
<tr>
<td>14.4.1</td>
<td>RTCA Software in MP Offline Mode</td>
</tr>
<tr>
<td>14.4.2</td>
<td>RTCA Software in MP Real-Time Mode</td>
</tr>
<tr>
<td>14.5</td>
<td>Example of Multiple Users Running Experiments on the same RTCA MP Instrument</td>
</tr>
<tr>
<td>15.</td>
<td>RTCA Software Functions Unique To The RTCA DP and RTCA TP Instruments</td>
</tr>
<tr>
<td>15.1</td>
<td>RTCA DP or RTCA TP Instrument Connection</td>
</tr>
<tr>
<td>15.2</td>
<td>DP or TP User Graphic Interface</td>
</tr>
<tr>
<td>15.3</td>
<td>The Combination of Using Multiple E-Plates 16 or CIM-Plate 16 Within an Experiment</td>
</tr>
<tr>
<td>15.4</td>
<td>Overview of Functions and Controls Unique to the RTCA DP or RTCA TP Instrument</td>
</tr>
<tr>
<td>15.5</td>
<td>Launch RTCA DP or RTCA TP Software</td>
</tr>
<tr>
<td>15.5.1</td>
<td>RTCA Software in DP or TP Offline Mode</td>
</tr>
<tr>
<td>15.5.2</td>
<td>RTCA Software in DP or TP Real-Time Mode</td>
</tr>
<tr>
<td>15.5.3</td>
<td>Set up RTCA DP or RTCA TP Software Default Pattern</td>
</tr>
<tr>
<td>15.5.4</td>
<td>RTCA DP or RTCA TP Software Auto-Scan at Startup</td>
</tr>
<tr>
<td>15.6</td>
<td>Example of Multiple Users Running Experiments on the RTCA DP or RTCA TP Instrument</td>
</tr>
<tr>
<td>C</td>
<td>Appendix</td>
</tr>
<tr>
<td>1.</td>
<td>Ordering Information</td>
</tr>
</tbody>
</table>
Table of Content

<table>
<thead>
<tr>
<th>Page</th>
<th>Section</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Introduction</td>
</tr>
<tr>
<td>2</td>
<td>Features and Benefits</td>
</tr>
<tr>
<td>3</td>
<td>Installation Guide</td>
</tr>
<tr>
<td>4</td>
<td>User Interface Overview</td>
</tr>
<tr>
<td>5</td>
<td>Functionality Explained</td>
</tr>
<tr>
<td>6</td>
<td>Appendix A: Troubleshooting</td>
</tr>
<tr>
<td>7</td>
<td>Appendix B: Technical Specifications</td>
</tr>
<tr>
<td>8</td>
<td>Appendix C: Credits</td>
</tr>
</tbody>
</table>

RTCA Software Manual – Software Version 2.1
Prologue

I. Revision History

<table>
<thead>
<tr>
<th>Manual Version</th>
<th>Revision Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.0</td>
<td>July 2016</td>
</tr>
</tbody>
</table>

© Copyright 2016, ACEA Biosciences, Inc. All rights reserved. Information in this document is subject to change without notice. No part of this document may be reproduced or transmitted in any form or by any means, electronic or mechanical, for any purpose, without the express written permission of ACEA Biosciences, Inc.

Questions or comments regarding the contents of this Manual can be directed to the address below or to your local ACEA representative.

ACEA Biosciences, Inc.
Customer Support
6779 Mesa Ridge Rd., Suite 100
San Diego, CA 92121
USA

Every effort has been made to ensure that all the information contained in the RTCA Software Manual is correct at the time of printing.

For new features and a list of remaining issues, please refer to the RTCA Software Release Note document located in the RTCA Software installation folder (By default under “C:\Program Files (x86)\RTCA\RTCA Software x.x\Document”).

However, ACEA Biosciences, Inc. reserves the right to make any changes necessary without notice as part of ongoing product development.

II. Contact Addresses

<table>
<thead>
<tr>
<th>Manufacturer</th>
<th>ACEA Bio (Hangzhou) Co, LTD.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Building 5, West Lake Technology &amp; Economy Park.</td>
</tr>
<tr>
<td></td>
<td>2# Xiyuan 5 Road Sandun, Hangzhou</td>
</tr>
<tr>
<td></td>
<td>Zhejiang, China, 310030</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Distribution in China</th>
<th>ACEA Bio (Hangzhou) Co, LTD.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Building 5, West Lake Technology &amp; Economy Park.</td>
</tr>
<tr>
<td></td>
<td>2# Xiyuan 5 Road Sandun, Hangzhou</td>
</tr>
<tr>
<td></td>
<td>Zhejiang, China, 310030</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Distribution in USA</th>
<th>ACEA Biosciences, Inc.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>6779 Mesa Ridge Rd., Suite 100</td>
</tr>
<tr>
<td></td>
<td>San Diego, CA 92121</td>
</tr>
<tr>
<td></td>
<td>USA</td>
</tr>
</tbody>
</table>

| International Distributors | For a complete listing of international distributors, contact ACEA Biosciences, Inc. or visit www.aceabio.com |
III. Trademarks

XCELLIGENCE, E-PLATE, and ACEA BIOSCIENCES are registered trademarks of ACEA Biosciences, Inc. in the US.

Other brands or product names are trademarks of their respective holders.

IV. Intended Use

The RTCA (Real-Time Cell Analyzer) SP (Single Plate), MP (Multiple Plate), DP (Dual Plate) and TP (Triple Plate) Instrument is intended for label-free, real-time, automated monitoring of cell status in a variety of cell-based assays, using proprietary microelectronic sensor technology developed by ACEA Biosciences. They can be used for both high throughput screening and research laboratory environments.

The RTCA SP, MP, DP and TP Instrument are intended for life science research and must be used exclusively by laboratory professionals who are trained in laboratory techniques and have studied the instructions for use of this instrument. The RTCA SP, MP, DP and TP Instruments are not intended for use in diagnostic procedures.

V. Software License Agreement

Read the following terms and conditions of this Software License Agreement (“Agreement”) carefully before installing or using the RTCA Software, hereinafter referred to as (“Software”). Proceeding with the installation of the Software or using the Software will constitute acceptance of the terms and conditions of this Agreement. By accepting the terms and conditions of this Agreement, the end-user (“Licensee”) assumes all responsibility and liability for the selection of this Software to achieve the intended results, and for its installation and subsequent use. If Licensee is not willing to be bound by the terms and conditions of this Agreement, the RTCA Instrument, including RTCA Software and Software package must be promptly returned to ACEA (“Supplier”) with a copy of the receipt against refunding of the purchase price for this Software.

1. Program License Agreement

Licensee assumes all responsibility and liability for the selection of this Software to achieve the intended results, and for its installation and subsequent use. The Software is protected by copyright.

2. Grant of Software License

Supplier grants to Licensee, a perpetual non-exclusive, single-use license to use the Software upon the terms and conditions contained in this Agreement.

Licensee may:

a. Use the Software on up to three workstations at a time and such workstations have to be owned, leased or otherwise controlled by Licensee, whether in a network or other configuration.

b. Transfer the Software by assigning the rights under this Agreement to another party, provided that (i) the other party agrees in writing to accept the terms and conditions of this Agreement, (ii) Licensee destroys any and all remaining copies of the Software still under its control upon completing the assignment, and (iii) Supplier is notified in writing of such assignment and destruction, including a copy of the assignee’s
written acceptance of the terms of this Agreement. In addition, Licensee must ensure that the copyright notice is maintained on the Software transferred. Upon any such assignment, any rights granted to the Licensee hereunder shall cease.

c. Reproduce the Software only to the extent as required for the contractual use of the Software. The required reproductions thus include the installation of the Software on the bulk storage of the applied hardware as well as loading it into the RAM of the device executing the Software. Furthermore, Licensee may reproduce the Software for back-up purposes but only to the extent necessary to ensure continued availability of the Software.

d. Reverse translate the object codes to other codes (decompilation) or perform any other forms of reverse engineering of the different development stages of the Software to the extent necessary in order to obtain the information required to achieve interoperability of the Software with an independently developed computer program and only to the extent such information cannot be obtained otherwise. Licensee shall however endeavour to obtain the required information from Supplier against reimbursement of expenses prior to any such operation.

Licensee may not:

a. Use the Software, in whole or in part, except as expressly provided in this Agreement.

b. Use the Software on more than three workstations at a time.

c. Copy, sell, or otherwise transfer the Software or assign its rights under this Agreement, in whole or in part, to another party, except as expressly provided in this Agreement.

d. Rent, distribute, license or sublicense the Software.

e. Create derivative works based on Software.

f. Modify, adapt, translate, reverse engineer, decompile or disassemble the Software except in the events and to the extent expressly provided in this Agreement. Supplier reserves all rights not expressly granted herein, including, but not limited to, the rights to market the Software either directly or through affiliates, distributors and/or third parties.

For further information, please contact your local AECA support organization.

3. **Limited Warranty**

Supplier warrants that its Software will, under Normal Use, comply and function in accordance with the specifications and associated documentation in all material respects for a period of twelve (12) months from the date of transfer of risk (“Warranty Period”). Normal Use is defined as storage, installation, operation and maintenance in accordance with Supplier’s instruction and good industry practice (“Normal Use”). Characteristics of the Software contained in any public statements of Supplier or its agents, in particular in advertisements, prospectuses or the labeling, or any custom of trade, only form part of the agreed quality if Supplier confirms them in writing.

Licensee shall document any arising defects in a manner that is conclusive and reproducible for Supplier and shall promptly notify Supplier following their discovery, if possible in writing. Licensee shall provide Supplier with all reasonable information required by Supplier to evaluate and eliminate the defects. Licensee is also obligated to cooperate in delimiting the defect. Supplier will examine and analyze the defects and provide a rectification within a reasonable period. Supplier may rectify a defect at its choice either i) by exchanging the Software, ii) by providing a reasonable workaround, or iii) by modifying the Software. Supplier may employ subcontractors to provide warranty services. Should Supplier finally refuse or fail to provide such remedy within a reasonable period or within an additional reasonable period, the Licensee is entitled at its choice to require the respective contract to be cancelled with respect to the defective unit of
Software License Agreement

Software or the payment to be appropriately reduced.

Warranty claims are excluded in cases of insignificant deviations from the agreed quality such as non-reproducible errors and natural wear and tear. They are also excluded if the Licensee used the Software for other than Normal Use and in particular if it is modified without the prior written consent of Supplier.

If the Licensee and Supplier have agreed a service level agreement that provides for service levels and service credits, such service level agreement will be the exclusive remedy with regard to all issues that are covered by the service levels. With the exception of the preceding sentence, this warranty is in place of and excludes all other warranties and conditions, whether oral, written, statutory, express or implied.

Should an inspection of a notice of defects by Licensee reveal that there is indeed no defect and/or that such defect is not caused by the Software, Supplier may claim compensation in the amount of Supplier’s regular hourly rates for the analytical effort in connection with Licensee’s notice of defects and for any other work related to such unjustified notice of defects.

4. Third Party Rights

During the Warranty Period, Supplier will indemnify the Licensee against all claims, losses, liabilities and reasonable costs which the Licensee may incur in defending any third party claim that the Software infringes any third party intellectual property rights provided that the conditions in this Clause are met.

If any third party claims infringement on the part of Licensee of the copyrights in the Software, Licensee shall promptly notify Supplier in writing of such claim and permit Licensor to any reasonable extent to conduct the defense of its rights. Licensee shall at its own charge provide Supplier with all reasonable support in such defense. In particular, Licensee shall submit to Supplier in writing, where possible, all required information regarding the use and, if applicable, any modifications of the Software and furnish any necessary documentation.

In the event of infringements of third party rights, Licensee may in its own discretion choose to rectify such infringement by

a) acquiring rights of use from the authorized owner of the protected right for the benefit of Licensee which are adequate for the purposes of this contract; or

b) modifying the infringing Software without affecting its functions and/or with effects that are acceptable to Licensee; or

c) supplying a new version of the Software, the contractual use of which does not infringe upon any protected rights of third parties in the program codes of the Software.

Save to the extent expressly agreed otherwise in this Clause 4, the provisions of Clause 3 above shall apply accordingly.

5. Disclaimer of Liability

Irrespective of the cause of action, Supplier’s liability shall be limited to damages caused by Supplier, its employees or subcontractors due to willful misconduct, gross negligence or, in case of a violation of an essential contractual duty, simple negligence.

If Supplier is held liable for simple negligence under the preceding paragraph, Supplier’s liability shall be limited to those typical damages that were reasonably foreseeable at the time the Agreement was concluded. It shall specifically exclude any lack of commercial
results, loss of income, indirect damages, and consequential damages arising from defects and third party claims, with the exception of claims due to infringement of third party protection rights.

Supplier’s liability for any damages caused by the breach of a specific warranty (Garantie, Zugesicherte Eigenschaft) or for damages to be compensated under the Product Liability Act and for damages due to loss of life, injury or prejudice to health remains unaffected.

For the avoidance of doubt, Licensee shall be responsible for the professional back-up of its data. Save for cases of intent, Supplier’s liability for lost data is hence limited to such data that would also have been lost if professional data back-ups had been made.

6. **Intellectual Property Rights, Indemnities**

Licensee shall only hold those rights to the Software that are expressly described in Clause 2 of this Agreement. Any other rights with regard to the Software, including without limitation, ownership rights and patent, copyright, trademark, trade secret and other intellectual property rights, shall remain the sole property of Supplier. Licensee will not remove from the Software any references to copyrights, trademarks or other ownership rights, or cover up or alter any such references. Licensee will take all reasonable steps to prevent any unauthorized use, reproduction, sale, or publication of the Software or the unauthorized provision of access thereto. Licensee will indemnify and hold harmless Supplier from any losses, damages, claims and expenses (including, without limitation, reasonable legal expenses) relating to any infringement of the rights of Supplier caused by Licensee, Licensee’s breach of this Agreement or Licensee’s use of the Software in a manner not authorized under this Agreement.

7. **Import, Export and Use of the Software**

Licensee shall be exclusively responsible for ensuring compliance with the relevant legislation relating to its rights to import, export or use the Software.

8. **Miscellaneous**

Should any part of this Agreement be declared void or unenforceable by a court of competent jurisdiction, the remaining terms shall remain in full force and effect. Failure of Supplier to enforce any of its rights in this Agreement shall not be considered a waiver of its rights, including but not limited to its rights to respond to subsequent breaches. By opening and using this Software Licensee acknowledges that he has read this Agreement, understands it, and agrees to be bound by its terms and conditions. Licensee further agrees that this Agreement is the complete and exclusive statement of the Agreement between Licensee and Supplier and supersedes any proposal or prior agreement, oral or written, any other communications between Licensee and Supplier relating to the subject matter of this Agreement. The headings of the several Clauses of this Agreement are intended for convenience of reference only and are not intended to be a part of or to affect the meaning or interpretation of this Agreement.

9. **Governing Law and Place of Jurisdiction**

This Agreement shall be governed by and construed in accordance with the laws of the United States of America, without giving effect to any choice of law principles thereof. The parties agree that the United Nations Convention on Contracts for the International Sale of Goods (1980) is specifically excluded from application to this Agreement.

The parties agree that the courts of San Diego, CA in the United States of America shall have exclusive jurisdiction over any dispute arising out of or in connection with this Agreement.
VI. Preamble

This RTCA Software Manual must be used in conjunction with the RTCA SP (or MP, or DP, or TP) Instrument Operator’s Manual. Before setting up the RTCA SP (or MP, or DP, or TP) Instrument, users should read the RTCA Software Manual and the RTCA SP (or MP, or DP, or TP) Instrument Operator’s Manual thoroughly and completely. Non-observance of the instructions contained in this manual may lead to safety hazards.

This Software Manual is prepared based on Windows 7 Operation System. For users who are using other supported OS systems, the screenshots and / or process step(s) may differ slightly. Consult your OS manual and / or IT support for help if it is needed.

VII. Usage of the Instrument Software Manual

This Software Manual will help users operate the RTCA SP (or MP, or DP, or TP) Instrument. It contains the following chapters:

Prologue contains RTCA Software version history and license agreement information.

Chapter A: About RTCA Software contains basic information about the RTCA Software.

Chapter B: Software Function describes the detailed RTCA Software functions and procedures for programming RTCA SP (or MP, or DP, or TP) Instrument runs and performing data analysis.

Chapter C: Appendix contains RTCA SP (or MP, or DP, or TP) Products Ordering Information.

VIII. Conventions Used in this Manual

Text Conventions

To impart information that is consistent and easy to understand, the following text conventions are used in this Software Manual:

<table>
<thead>
<tr>
<th>Numbered Listing</th>
<th>Steps in a procedure that must be performed in the order listed.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Italic type, gold</td>
<td>Refers to a different chapter in this Software Manual that should be consulted.</td>
</tr>
<tr>
<td>Italic type</td>
<td>Describes buttons, icons or functions when operating the RTCA Software. In addition, important notes and information notes are shown in italic style.</td>
</tr>
</tbody>
</table>

Symbols

In this Software Manual symbols are used as an optical signal to point out important things.

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Heading</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>!</td>
<td>IMPORTANT NOTE</td>
<td>Information critical to the success of the procedure or use of the product.</td>
</tr>
<tr>
<td>🔄</td>
<td>INFORMATION NOTE</td>
<td>Additional information about the current topic or procedure.</td>
</tr>
<tr>
<td>▶️▶️▶️</td>
<td>Table continued on next page.</td>
<td></td>
</tr>
<tr>
<td>■</td>
<td>End of table.</td>
<td></td>
</tr>
</tbody>
</table>
A About RTCA Software

RTCA Software is an integrated software for operating the following 4 RTCA instruments:

- RTCA SP (Single Plate) Instrument (here and after refer as “SP”)
- RTCA MP (Multiple Plate) Instrument (here and after refer as “MP”)
- RTCA DP (Dual Plate) Instrument (here and after refer as “DP”)
- RTCA TP (Triple Plate) Instrument (here and after refer as “TP”)

The basic GUI (Graphic User Interface) and operation of the SP, MP, DP and TP are similar. To reduce redundancy, this manual describes only once the common functionalities of all 3 instruments (SP, MP, DP and TP). The descriptions for common features are based on the SP instrument. MP, DP and TP users should read the chapters specifically prepared for your instrument, then refer to the related chapters for common functionalities and operations.

The RTCA Software has two work modes: Real-Time and Offline mode.

- Real-Time mode: RTCA Software is synchronizing with the RTCA Instrument (SP, MP, DP and TP), even when there is no experiment running.
- Offline mode: RTCA Software is not connected to RTCA Instrument, or the connection between the RTCA Control Unit and instrument is absent.
1. System Requirements and RTCA Software Installation

1.1 System Requirements

The RTCA Control Unit is delivered with the RTCA Instrument. The following Hardware and Software requirements are only necessary if you plan to install the RTCA Software on an additional computer.

Hardware (Computer):

- CPU speed: minimum 1 GHz
- RAM: minimum 256 MB
- Hard Drive free space: minimum 100 MB
- Monitor Resolution: 1024 × 768 or higher

- RTCA Software is designed to handle one E-Plate with the RTCA SP Instrument, multiple E-Plates with MP Instrument, multiple E-Plates 16 or CIM-Plate 16 with RTCA DP Instrument and multiple E-Plates 16 for TP Instrument.

Software:

- Windows XP/Windows Vista/Windows 7
- Microsoft Office 2003 or newer (optional, for better data analysis performance)

- Regional and Language Options should be set to English (United States). Date/Time/Number should also be set to U.S. styles. Any other settings might lead to problems in data analysis and instability of the Software.
System Requirements and RTCA Software Installation

System Requirements

Settings of the RTCA Control Unit:

Since the RTCA SP Instrument is a real-time data measuring system, the computer power scheme must be set as follows: Never turn off hard disks; Never standby; Never hibernates. Setting “Turn off monitor” to Never is optional.

Logon to Windows Operating System

The RTCA Control Unit is delivered with the following Windows Operating System users preinstalled:

<table>
<thead>
<tr>
<th>User Name</th>
<th>Default Password</th>
<th>Group</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>RTCAOperator</td>
<td>No password</td>
<td>Power Users</td>
<td>Default user for instrument operation. Click RTCAOperator (No password) to log in Windows when Windows starts.</td>
</tr>
<tr>
<td>RTCAdmin</td>
<td>sandiego</td>
<td>Administrators</td>
<td>Administrator is able to perform administrative operations such as:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>► Change date and time settings</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>► Perform software updates</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>This password should only be distributed to IT or lab administrators.</td>
</tr>
</tbody>
</table>

How to Change Windows Users

1. Start the RTCA Control Unit

2. Click RTCAOperator (No password), or RTCAdmin. If RTCAdmin is clicked, password is required in order to login.
1.2 Install RTCA Software

1.2.1 Install RTCA Software

Extract the RTCA Software setup package to local folder.

1. Double-click on the Setup.exe file in the setup package folder to launch it manually. Select the installer language from the menu that appears, and click OK.

2. A dialog box will appear, notifying you of the software version that you will be installing and recommending that you close all other applications before proceeding. Please follow this instruction, and click Next to continue the installation.
3. A second dialog box will appear informing you of the RTCA Software license agreement. Please review this agreement carefully. Select I Agree to accept the terms and proceed with installation.

4. Select the installation folder from this dialog box, you can either accept the default installation folder (recommended), browse-select a folder, or type a path and folder name where the software will be installed.

   - To browse-select a folder: Click Browse… and choose an existing folder.
   - To type in folder name: Click a textbox under Destination Folder. If the folder does not exist, the installation program will create a new folder.

   The folder name should not include “?”, “*” or “*”.

   The default installation folder is C:\Program Files (x86)\RTCA\RTCA Software x.x. (where x.x indicates the version of the software being installed).

After choosing the installation folder, click Install to proceed.

If previous version of RTCA software was installed in the computer before, the new version installation program will remove/uninstall the old RTCA Software in order to continue the installation. A dialog window is shown asking if you want to continue:
Install RTCA Software

Click the **Yes** button to remove/uninstall the old RTCA software, and continue the new version installation.

Click the **No** button to keep your old RTCA software, and quit the installation program.

ACEA recommends users to upgrade to the newest version of RTCA software.

Select **Finish** from the RTCA Software Setup window to complete the installation. The software is now ready to use.

**1.2.2 Launch RTCA Software**

Two short-cuts for launching RTCA Software are available after installation:

- Computer Desktop
Computer Program Menu

- Notepad
- NovoExpress
- Oracle VM VirtualBox
- PDFCreator
- PicPick
- Python 3.4
- RTCA Cardio Software 1.0
- RTCA CardioECG Software 1.2
- RTCA Data Analysis Software 1.0
- RTCA DI Plus Software 1.0
- RTCA Software 2.1
  - RTCA Software Help
  - RTCA Software Manual
  - Uninstall
- Spyder
- SQLite Expert
- SQLite OD/BE Driver
- Startup
- VideaLAN
- Visual Studio 2015
- WeChat
- Windows Kits
- xMFT Software 1.0
- Back

Search programs and files
1.3 Uninstall RTCA Software

There are two ways to uninstall RTCA Software from the computer:

► Click Start on Windows toolbar, and then follow the steps shown below:

Start → Settings → Control Panel → Add or Remove Programs, then highlight RTCA Software x.x, click Uninstall/Change.

► Alternatively, use the Computer Program Menu:
1.4 User Management

There are three built-in usernames in the RTCA Software. They are: *Administrator, User1, and User2.*

To change a user’s password:

► Login to RTCA Software with a valid username and password.
► Click User Management from Setup menu.
► Enter current password in Old Password box.
► Enter new password in New Password box.
► Re-enter new password in Confirm Password box.
► Click Change Password button.

Please note that the password of Administrator should contain 4-20 characters.

The default password of the built-in user ADMINISTRATOR is administrator (all lower case). The default passwords of built-in users User1 and User2 are not set (empty).

The Administrator can change/reset all other users’ passwords without knowing those passwords.

To add a new user:

► Login as Administrator.
► Enter a new user’s username in User Name box.
► Click Add User button.

The default new user’s password is the same as the username (all lower case).

To delete a user:

► Login as Administrator.
► Select a username from the User Name drop down list.
► Click Delete User button.
► In the pop-up window “Are you sure to delete?”, click Yes to delete, click No to cancel.

Only the Administrator can delete users.
2. Entering SP, MP, DP or TP Real-Time Mode Automatically

When the RTCA Instrument is powered on and connected to RTCA Control Unit, the RTCA Software will enter real-time mode directly.

When the RTCA Software starts, it will automatically detect the RTCA Instrument connected to the RTCA Control Unit (computer). Based on the instrument configuration, the RTCA Software will launch RTCA SP, RTCA MP, RTCA DP, or RTCA TP user interface directly.
Entering SP, MP, DP or TP Real-Time Mode Automatically

RTCA DP User Interface

RTCA TP User Interface
3. Entering SP, MP, DP or TP Offline Mode

When the RTCA Software starts, if no RTCA Instrument is connected to the RTCA Control Unit, or the connected RTCA Instrument is not turned on, the RTCA Software will show a dialog window that allows users to choose the RTCA Software running mode:

![Dialogue Window for the RTCA offline mode selection](image)

With this window, the user can click one of five different buttons (from top to bottom):

- **Retry Button**: The RTCA Software will try to reconnect to RTCA Instrument.

Make sure the 4 conditions for entering SP or MP real-time mode have been met:

1. The serial communication cable between RTCA Control Unit and RTCA Analyzer must be connected securely;
2. The RTCA Analyzer is turned on;
3. A RTCA SP Station or RTCA MP Station is connected to the RTCA Analyzer;
4. No other RTCA Software is running.

Make sure the 2 conditions for entering DP or TP real-time mode have been met:

1. Make sure the USB cable between the RTCA Control Unit and the DP or TP Analyzer is connected securely, and that at least one of the DP or TP LED indicators is on.
2. No other RTCA Software is running.

- **SP Offline Button**: The RTCA Software will enter SP offline mode.
- **MP Offline Button**: The RTCA Software will enter MP offline mode.
- **DP Offline Button**: The RTCA Software will enter DP offline mode.
- **TP Offline Button**: The RTCA Software will enter TP offline mode.
- **Quit Button**: The RTCA Software will close.
When either SP Offline, MP Offline, DP offline or TP offline is selected with the “remember my choice” box being checked, the RTCA software will enter the selected offline mode (SP, MP, DP offline or TP offline) directly if no RTCA Instrument is connected.

The Offline preference does not affect the real-time mode, i.e., even when the “remember my choice” option was selected, the RTCA Software will detect a connected RTCA SP, MP, DP or TP Instrument the next time, and it will enter into the RTCA SP, MP, DP or TP real-time mode automatically (depending on which instrument has been detected).

The Offline preference settings can be cleared using the command line parameter “x” (see below).
4. RTCA Software Command Line Parameters

RTCA Software supports the following command parameters:

- S Enter SP offline mode directly
- M Enter MP offline mode directly
- D Enter DP offline mode directly
- T Enter TP offline mode directly
- X Clear Offline Preference setting

Example: Run “RTCA.exe” with parameter “x” to clear offline preference setting.

(From the Windows status bar) Start → Run, type “C:\Program Files (x86)\RTCA\RTCA Software x.x\RTCA.exe” x in the “Open” box (x.x indicates the version of the software being installed), and click OK.

Note: the command must include the quotation mark (") and there is a space between the command and the parameter x.
5. How to Use this Software Manual

The basic functions and operations of RTCA SP Instrument, RTCA MP Instrument and RTCA DP or RTCA TP Instrument are similar. In Chapter B Software Functions, the common functions and operations of RTCA Software are described in Sections 1 through 13, using the SP offline mode as an example. Thereafter, the functions and operations for exclusively the RTCA MP Instrument and RTCA DP or RTCA TP Instruments, are covered in Section 14 and Section 15, respectively.

The RTCA SP Instrument user should thus read only Sections 1 through 13, ignoring Sections 14 and 15. The RTCA MP Instrument user can consult Section 14 first to become familiar with the RTCA Software MP user interface; the RTCA DP or RTCA TP Instrument user can consult Section 15 first to become familiar with the RTCA Software DP or RTCA Software TP user interface, but all RTCA MP, DP and TP users must then read Sections 1 through 13 for details on RTCA Software functions.
B Software Function

This chapter describes the main functions of the RTCA Software for configuring, monitoring, and analyzing the experiment.

1. Overview of the RTCA Software

The user-friendly RTCA Software provides outstanding instrument control for flexible experiment set-ups, data acquisition and data analysis. All instrument and experiment controls are contained in the software to simplify experiment set-up and operation. The RTCA Software consists of nine different functional pages:

Experiment Set-up pages:
- Exp Notes page
- Layout page
- Schedule page

Experiment Monitoring and Data Analysis pages:
- Cell Index page
- Plot page
- Well Graph page
- Data Analysis page
- Message page
- Audit Trail page

The first three pages contain functions required for running experiments. The other six pages contain functions for monitoring and analyzing experiments. Special features programmed into the RTCA Software provide the flexibility needed for dynamic measurement of cell status in the wells. Based on experiment requirements, the Software can be programmed to take measurements over any time interval, from less than one minute to over a day, and at any frequency, from hours to days or weeks. The real-time data acquisition, data normalization, and data plotting functions allow the user to monitor experiments in real-time. The Software can analyze experimental results, such as Cell Index doubling time, IC\textsubscript{50} values, or EC\textsubscript{50} values, at a given time interval, or determine time-dependent IC\textsubscript{50} or EC\textsubscript{50} values for the entire treatment period after compound addition.
1.1 Software Functions

The following describes the functions and utilities of the RTCA Software that control the RTCA Instrument.

The user interface of the RTCA Software in the SP Instrument contains (from the top to bottom): Main Menu, Plate Window Menu, Tool Bar, Page Tabs, and Status Bar.
## Overview of the RTCA Software

### Software Functions

<table>
<thead>
<tr>
<th>Item</th>
<th>Example</th>
<th>Major Function</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Main Window</strong></td>
<td><img src="image" alt="Main Window Screenshot" /></td>
<td>Handles all functionalities of an individual experiment on one E-Plate</td>
</tr>
<tr>
<td><strong>Plate Window</strong></td>
<td><img src="image" alt="Plate Window Screenshot" /></td>
<td></td>
</tr>
<tr>
<td><strong>Main Menu</strong></td>
<td><img src="image" alt="Main Menu Screenshot" /></td>
<td>User actions to operate RTCA Software</td>
</tr>
<tr>
<td><strong>Plate Window</strong></td>
<td><img src="image" alt="Plate Window Screenshot" /></td>
<td>User actions to handle all functionalities on one or multiple E-Plates</td>
</tr>
<tr>
<td><strong>Plate Window</strong></td>
<td><img src="image" alt="Plate Window Screenshot" /></td>
<td>Short-cuts of frequently used menu functions</td>
</tr>
<tr>
<td><strong>Page Tabs</strong></td>
<td><img src="image" alt="Page Tabs Screenshot" /></td>
<td>Work area; user-defined information</td>
</tr>
<tr>
<td><strong>Status Bar</strong></td>
<td><img src="image" alt="Status Bar Screenshot" /></td>
<td>Displays Instrument working status</td>
</tr>
<tr>
<td>Icon</td>
<td>Description</td>
<td></td>
</tr>
<tr>
<td>------</td>
<td>-------------</td>
<td></td>
</tr>
<tr>
<td>![Image]</td>
<td>Open an experiment .plt file</td>
<td></td>
</tr>
<tr>
<td>![Image]</td>
<td>Apply changes made in the Layout or Schedule page</td>
<td></td>
</tr>
<tr>
<td>![Image]</td>
<td>Add a step</td>
<td></td>
</tr>
<tr>
<td>![Image]</td>
<td>Delete a step</td>
<td></td>
</tr>
<tr>
<td>![Image]</td>
<td>Start a step</td>
<td></td>
</tr>
<tr>
<td>![Image]</td>
<td>Pause a step</td>
<td></td>
</tr>
<tr>
<td>![Image]</td>
<td>Abort current running step</td>
<td></td>
</tr>
<tr>
<td>![Image]</td>
<td>Scan Plate</td>
<td></td>
</tr>
<tr>
<td>![Image]</td>
<td>Stop Plate Scan</td>
<td></td>
</tr>
<tr>
<td>![Image]</td>
<td>Undo</td>
<td></td>
</tr>
<tr>
<td>![Image]</td>
<td>Redo</td>
<td></td>
</tr>
</tbody>
</table>
1.1.1 RTCA Software Functions Required for Running Experiments

*Exp Notes Page: Record key information about the experiment*

*Layout Page: Define arrangement of samples on E-Plate 96 (e.g., cell type, cell number, compound name, concentration)*
Overview of the RTCA Software

Software Functions

Schedule Page: Set up parameters for real-time data acquisition, such as the number of sweeps and time interval for each sweep, for each experiment step.

1.1.2 RTCA Software Functions Required for Monitoring Experiments

Cell Index Page: Real-time data acquisition and monitoring.
Overview of the RTCA Software

Software Functions

**Well Graph Page:** Shows all graphs of all well data in E-Plate format (8 x 12).

**Plot Page:** Multiple data plot and data export functions.

**Data Analysis Page:** Multiple data analysis functions (e.g., $IC_{50}/EC_{50}$, Cell Index doubling time, Slope, etc.)
**Overview of the RTCA Software**

**Software Functions**

**Message Page:** Record and report the major steps of the experimental process.

**Audit Trail Page:** Record and report every action user has made that would modify the experiment file.
2. Starting an Experiment

Often there are several ways to access functions in this Software (“right-clicking”, “menus”, “icons”). Although this Manual describes one method, users should familiarize themselves with the other available methods and use the one they prefer.

2.1 Launch the RTCA Software

Double-click the RTCA Software x.x Icon on the desktop to launch the application. A login window appears. All user names are shown in a drop-down list. Choose a user name and enter the corresponding password to login to the RTCA Software.

The default password of the built-in user ADMINISTRATOR is administrator (all lower case). The default passwords of built-in users User1 and User2 are not set.

After launch, the RTCA Software will initialize the COM port, using previously saved settings. One of the following will happen:

► If RTCA Instrument (RTCA Analyzer and RTCA Station) is powered on and connected to the RTCA Control Unit properly, the RTCA Software will try to communicate with the RTCA Instrument and obtain related information. As soon as the connection is successfully established, the software will display the instrument information, such as Analyzer Model, Analyzer SN (serial number), Station Model, Station SN, etc. on the main interface. Also the Software will enter Real-Time mode directly.

► If the designated port number is not available, or the set port is available, but the Software fails to communicate with the RTCA Analyzer, the Software will provide the user with five options: (1) select Retry to try to reconnect to the RTCA Instrument, (2) select SP Offline mode, (3) select MP Offline mode, and (4) select DP Offline mode; and (5) Quit the RTCA Software.
2.2 Check the Software Version

Click Help in the Menu bar of the RTCA Software and use the menu to select About RTCA. This will activate a pop-up box displaying the Software version that is installed on the RTCA Control Unit or computer.

![About RTCA Software](image)

2.3 Menus of Main Window and Plate Window

2.3.1 Main Menu

The main window menu contains three sub-menus: File, System, and Help.

File

Exit: Close RTCA Software.

System

Logout: Logout to protect the experiment

Setup: Change system settings

User Management: Change password, add / delete users

Help

Help Topics: Providing on-line help functions

Software Manual: Open Software Manual in PDF format. (Adobe Reader is required)

About RTCA: Information about RTCA Software
Starting an Experiment

Menus of Main Window and Plate Window

2.3.2 Plate Window Menu

The Plate Window menu has five sub-menus including File, Edit, Setup, Steps, and Execute.

Plate Menu and Tool bar

Plate

Open: Open an experiment

Open Old Version: Open an experiment from an old version of RTCA Software

Allow Everyone Open: Remove protection of currently opened experiment

Release: Clear all the information on all the pages

Reserve: Reserve one plate for later use

Save: Save current experiment

Create a Problem Report: Create a problem report for sending to ACEA representative

Export Experiment Info: Export experiment details to an Excel file

Print Current Page: Print displayed page

Print All Pages: Print all pages

Edit
Starting an Experiment

Menus of Main Window and Plate Window

---

**Undo**: Rollback changes at Layout page

**Redo**: Reapply changes at Layout page

**Cut**: Cut information

**Copy**: Copy information

**Paste**: Paste information

**Select All**: Select all information or all wells

**Clear**: Clear information

### Setup

#### Frequency

Set up measurement frequency for SP, MP or DP instrument.

- **Frequency**: All 3-Frequency or any one of them can be selected for SP, MP or DP instrument. But only 10kHz is available for TP instrument.

#### Curve Adjustment Tools

- **Curve Adjustment**: Tools for adjusting Cell Index curves

#### Clone Individual Page

- **Clone Individual Page**: Copy settings for individual page (Exp_Notes, Layout, and Schedule)

#### Clone Experiment

- **Clone Experiment**: Copy all settings for ExpNotes, Layout, and Schedule pages

#### Save Analysis Template

- **Save Analysis Template**: Save data analysis items as a template to be used to analyze the other data file

#### Load Analysis Template

- **Load Analysis Template**: Load the saved data analysis template

#### Manage Analysis Template

- **Manage Analysis Template**: Change the setting for the saved data analysis template

### Steps

#### Add a Step

- **Add a Step**: Add a new step to experiment

---

*Software Function*
Starting an Experiment

Experiment Record

Delete a Step: Delete selected step

Execute

Start/Continue: Start a step, or resume step that is currently paused

Pause: Pause current step

Abort Step: Skip remaining sweep(s) of currently running step

Scan Plate: Perform a measurement on all selected wells in the plate

Stop Scan Plate: Stop plate scanning, ignore the scanned data

Lock Plate: Lock E-Plate (MP only)

Unlock Plate: Unlock E-Plate (MP only)

2.4 Experiment Record

The Exp Notes page contains fields in which the user can record experimental details.

The RTCA Instrument can run an experiment even if Exp Notes page is blank.

The information on the Exp Notes, Layout, and Schedule pages will automatically be saved in an experiment file when the user clicks the Start/Continue icon before starting a new experiment. The default file name is:

- YYMMDDHHmm_ExperimentName.plt for SP
- YYMMDDHHmm PPlateNumber_ExperimentName.plt for MP
- YYMMDDHHmm DPlateNumber_ExperimentName.plt for DP
- YYMMDDHHmm TPlateNumber_ExperimentName.plt for TP

where Experiment Name is the user-entered text in the Experiment Name box on the Exp Notes page.

The information on the Exp Notes page can be edited while the experiment is running or after the experiment has finished. After the experiment has started, if the user adds or changes information on the Exp Notes page, they must save this page manually by clicking the Save Changes icon.

To save the information on the Exp Notes page manually before the experiment is started, click the Save Changes button. A Save As window will open, displaying a default page name in the file name box. The default name is TemplateYYMDDD.pkt for SP, TemplateYYMDDPPlateNumber.pkt for MP, TemplateYYMDD DPlate-Number.pkt for DP, and YYMMDDHHmm TPlateNumber_ExperimentName.pkt for TP. You can type a different name if desired. Click the Save button on the window. The Exp Notes page information will be saved in the file. Such a file can be opened as a template for future experiments.
To insert the cursor in a text box, left-click the mouse in that box. Once the cursor has been inserted into one text box, use the Tab key to move from text box to text box, or, alternatively, use the mouse again to insert the cursor in the next text box.

A backup copy of the RTCA data file (*.bak) will be generated at the same time as the RTCA data file (*.plt). The backup copy of the data file can be saved either to the default directory of "\[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Explorer\Shell Folders\] key “Common Documents” or to a user-defined directory.

For example, for Windows 7 English version, the default directory of the RTCA data file is: C:\Users\Public\RTCA Data, and the default directory of the backup copy of the RTCA data file is: C:\Users\Public\RTCA Backup Data.

2.5 Text Boxes on Exp Notes Page

► User: The login user name is displayed in this box and cannot be changed (read-only).

► Data Directory: the default path is to C:\Users\Public\RTCA Data \login username. To direct the path to a different folder on the RTCA Control Unit, use the Browse… button to locate and open the folder.

Since an experiment can continue for a long time, the RTCA Software reads from and writes to the experiment data file from time to time. Therefore, the file directory must be a fully accessible folder stored on the local hard drive.

► Experiment Name: User-defined information. Use the mouse or Tab key to move the cursor to this text box. This information will be saved as part of the experiment file name.

► Device Part No.: Entering the serial number of the E-Plate here will allow the user to monitor the quality of the experiment and track any possible issues with the E-Plate Plate. Entering the E-Plate serial number is highly recommended. Use the mouse or Tab key to move the cursor to this text box.

► Experiment Purpose: User-defined information. Use the mouse or Tab key to move the cursor to this text box.

► Experiment Procedure: User-defined information. Use the mouse or Tab key to move the cursor to this text box.

► Experiment Conclusion: User-defined information. Entered after experiment has finished to record the main conclusions about the experiment. Use the mouse or tab key to move the cursor to this text box. Most likely this information would be added after the experiment has finished. So, in order to save the added information, click the Save Changes button while the Software is displaying the Exp Notes page.

After the experiment starts, any changes made on the Exp Notes page must be saved manually using the Save Changes button.

The Experiment ID is displayed on the top bar of the software window. Before an experiment starts, the default ID is the current date (YYMMDD) and time (asterisks). When an experiment is started, the default ID changes to the current date and time (YYMMDDHHmm), and the experiment file name is YYMMDDHHmm_ExperimentName.plt for SP, YYMMDDHHmm_PlateNumber_ExperimentName.plt for MP, YYMMDHHmm_DPlateNumber_ExperimentName.plt for DP, and YYMMDDHHmm_TPlateNumber_ExperimentName.plt for TP, where Experiment Name is the user-defined information from the Experiment Name box. During an experiment or after completion of an experiment, the Experiment ID will not change even if the experiment file name is changed.
The information recorded or edited on the Exp Notes page is not required for running an experiment. However, such information is very useful for later reference.

### 2.6 Example of a Completed Exp Notes Page

An example of a completed RTCA Exp Notes page.
3. **Design an Experiment**

3.1 **Experiment Layout**

Click on the *Layout* page tab (shown in the figure below). This page allows the user to enter detailed information for each well. Correct information about each well is essential for monitoring experimental data on the *Plot* page during the experiment.

*Layout* data is saved automatically when the experiment is started.

- The user can enter or edit the layout information either before the experiment starts or after it finishes.

To save any changes made in the *Layout* page after an experiment has finished, click the *Save Changes* button.

- To prevent invalid data or loss of data, the RTCA Software does not allow the user to turn on or turn off any wells (see below) during the experiment.

3.2 **Add Experimental Information**

For RTCA Instrument, each box on the well map represents one well of an E-Plate 96 on the RTCA SP or MP Station. Once all information about the wells has been entered in the text boxes, click the *Apply* button to add that information to the well map.

- Information entered into the text boxes will not be transferred to the well map if the *Apply* step is omitted.
3.3 Enable Wells

In order to run an experiment on your sample wells, you must first enable, then activate those wells, as follows:

1. Enable the wells you will be using on the E-Plate by highlighting the light blue boxes on the well map that correspond to those wells. The enabled wells will turn dark blue. For convenience, there are many ways to highlight different boxes on the map:
   - Holding the Ctrl or Shift key while clicking will highlight all clicked boxes.
   - Clicking on one box and dragging across others will highlight multiple boxes.
   - Clicking a column number will highlight the entire column of boxes.
   - Clicking a column number, then clicking and dragging the mouse across others will highlight multiple columns.
   - Clicking a row letter will highlight the entire row of boxes.
   - Clicking a row letter, then clicking and dragging the mouse across others will highlight multiple rows.

2. Go to the information text boxes (above the well map) and type in specific information such as Cell Type, Cell Number, Compound Name, Concentration, etc. for the enabled wells. (This step is optional; see details below).

3. Click the Apply button to transfer the information from the text boxes (if any) to the highlighted wells on the well map and activate those wells. After the Apply button has been clicked, the activated wells on the well map will be lighter in color (no longer dark blue) and contain the information that was typed into the text boxes.
   - This step must be performed before the experiment can start.

Right-clicking on the page will provide a drop-down menu that allows you to perform several commands, such as “Apply”.
3.4 Information Boxes

Entering information in these text boxes is optional. You can still perform an experiment even if no information appears in the text boxes, but you will not be able to use some of the functions on the Plot and Data Analysis Pages.

► Cell Type:
Enter the name of the cell types you are using.

No space / blank are allowed for the Cell Type.

► Cell Number:
Enter the number of cells seeded in a well.

► Compound No.:
If multiple compounds are to be added to the same well(s), you can assign each compound a number from this drop-down menu. After entering information about the first compound in the text boxes below (Compound Name, Concentration, etc.), select “2” from this menu and enter information about a second compound in the boxes. To check the names of multiple compounds assigned to the same well, the user must select the number that is assigned to each compound. Note that the well in the layout map will display each compound in a column (one beneath another).

► Compound Name:
Enter compound name or names.

No space / blank are allowed for the Compound Name.

► Concentration:
Enter compound concentration. This function can also be used to indicate a dilution series.

To define a dilution series, use this field in conjunction with the Dilution Factor, Repetition, Along fields and High From (which give details about the dilution series). First enter in the Concentration box the highest concentration used; then, the dilution series will start with this concentration and proceed as defined in the other fields.

► Unit:
Select a unit for your compound from this drop-down menu. To add your own unit, select -define- from the menu and type your unit name into the text box.

If you select a user defined unit (“-define-”) it is not possible to perform certain calculations on the Data Analysis page, e.g., Dose Response Curves (DRCs). An error message will appear.

► Dilution Factor:
For a dilution series, you must enter the dilution factor that will be used. For example, for a 3-fold dilution from well to well, enter 3. The default value is 1 if nothing is entered in the text box.
A new function of RTCA Software for better illustration of Dilution Factor in the Layout page is by selecting the Color checkbox. To use this function, select multiple wells with Dilution Factor applied. Input the Compound Name, Concentration, and Dilution Factor information for the selected wells. Then click the Color checkbox and assign a specific color for this compound. You can also adjust the intensity of the color assigned for each concentration. Then click the Apply button. The information will be displayed on each box with specific color whose intensity corresponds to the compound concentration.

► **Repetition:**

If a dilution is to have replicates, enter the number of replicates here. The default value is 1 if nothing is entered in the text box. Replicates can be down a column or across a row (as defined by the “Along” box below).

► **Along:**

Indicate whether the serial dilution and/or repetition is to proceed along a row or a column.

► **High From:**

Starting point of the dilution series. If you want the dilution series to proceed along a row (as defined in the “Along” box below), select Left or Right to indicate whether the highest concentration will be in the left-most or right-most well of that row. If you want the dilution series to proceed along a column, select Top or Bottom to indicate whether the highest concentration will be in the top or bottom well of that column.

► **Apply:**

Use this button to transfer all the information from the text boxes to the well map.

**Information entered into the text boxes above will not be transferred to the well map if the Apply step is omitted.**

### 3.5 Example of a Completed Layout Page

In order to view detailed information for each well, just simply place the cursor on that well, a Tool Tip Message will show to list its details.
In the RTCA Software, the term “µ” as a dimension unit is always shown as “u” (e.g., uM instead of µM).

In the above figure, a dilution factor of 2 is selected. The highest concentration is 100 µM. The repetition number of 2 means the first concentration repeats 2 times, then the next concentration 2 times downward along the column etc., since Along Column was selected.

If you need to change the information inside the well map, you must re-select the wells that need to be changed, then right-click and select Clear from the pop-up menu that appears. The selected wells will still be turned on, but will contain no information. You can then enter the correct information.

If you need to change the color inside the well map, you must re-select the wells that need to be changed, then right-click and select Clear Color from the pop-up menu that appears.

If you need to add another compound to the map you can select the affected wells, then type in the compound information and click Apply. A pop-up box will appear. Select Yes if you want to add a new compound to this well. Select No if you want to replace the original compound in the well with the new compound. Select Cancel if you do not want to add this compound. An alternative way to add another compound to the map is to select “2” from the Compound No. menu, then type in the compound information and click Apply.

The Dilution function can also be used for Cell Titration.
3.7 Copy/Paste Layout Settings

For your convenience, the RTCA Software offers Copy and Paste functions to help set up the Layout page.

Copy and Paste can be done within the Layout page. In addition, you can Copy to / Paste from Microsoft Excel or other Windows applications.

The following steps/figures show how these functions work.

1. Copy source well(s)
   Use the left mouse key to highlight the source well(s). Then right-click, select Copy from the menu, and select the item to be copied:
   - **Well(s) Information**: Copy all information in the well(s)
   - **Cell Type & Number**: Copy Cell Type and Cell Number only
   - **Cell Type**: Copy Cell Type only
   - **Cell Number**: Copy Cell Number only
   - **Compound & Concentration**: Copy Compound and Concentration
   - **Compound**: Copy Compound Name only
   - **Concentration**: Copy Concentration and Unit

![Source Well Selection](image1)

2. Paste to target well(s)
   Right-click the target cells, select Paste from the menu, and then select the item to be pasted:
   - **Well(s) Information**: Paste all information in the well(s)
   - **Cell Type & Number**: Paste Cell Type and Cell Number only
   - **Cell Type**: Paste Cell Type only
   - **Cell Number**: Paste Cell Number only
   - **Compound & Concentration**: Paste Compound and Concentration
   - **Compound**: Paste Compound Name only
   - **Concentration**: Paste Concentration and Unit

   ![Target Well Paste](image2)

   *If an item was Copied within RTCA Software, only the Copied item will be available on the menu for Pasting.*
4. Experiment Schedule

There are several ways to access functions in this Software (“right-clicking”, “menus,” “icon”). This Manual describes only one method, but users should familiarize themselves with the other methods so they can use the one they prefer.

Click the Schedule tab to display the Schedule setting page. This page allows:

► Adding (or deleting) experiment steps
► Setting the measurement parameters for each step

A Step is one part of an experimental set-up. Typically, an experiment consists of at least three different steps: 1. Background measurement; 2. Cell addition and monitoring of cell attachment and proliferation; 3. Addition of a test compound and monitoring of cellular reactions to that compound.

In the Schedule page of RTCA Software, there are three parts which designed for setting the Schedule Parameters, displaying Estimated Time Chart and File Size, and displaying the Step Information, respectively.

4.1 Add Steps and Set Measurement Parameters

There are several ways to add steps to the Schedule page:

► Click the Step icon on the tool bar, or
► Click Steps from the menu; then select Add a Step, or
► Right-click mouse and select Add a Step from the pop-up menu.

After one step is added, it will be highlighted in the Step Information table of the Schedule page. Input the parameters in the Schedule Parameters Setting for this step, and click Apply button to finalize the setting.

To change the schedule of a step, click the step in Step Information table, then move the cursor to the text boxes and make the changes for each parameter. To confirm the changes, click the Apply button. The new settings will appear in the Step Information table.
**Experiment Schedule**

*Add Steps and Set Measurement Parameters*

### 4.1.1 Schedule Parameter Setting

The top part of the *Schedule* page is for setting the measurement parameters for each step:

- **Step:**
  
The name of each step. By default, it will be Step_1, Step_2, etc. if this parameter is not changed by users.

- **Sweeps:**
  
  One Sweep means a continuous acquisition of resistance data from all the wells selected in the *Layout* page for a certain amount of time (*Sweep Duration*).

- **Interval:**
  
  *Interval* is a parameter to determine how often one Sweep takes place. The unit for Interval can be selected as hour, minute, or second.

  For example, if the *Interval* is set to be 10 minutes, it means that one sweep will be initiated every 10 minutes.

  **Interval should be set larger than the Sweep Duration (see below).**

- **Duration:**
  
  Duration determines how long that one step will last. For a fixed Interval, you can either adjust *Sweeps* or *Duration* in order to set the whole time that one step will actually last for. For *Duration*, there are three boxes that allow you to specify hour/minute/second (hh:mm:ss).

  For example, if one step is designed to last for 24 hours with the *Interval* of 10 minutes, either 145 *Sweeps* or *Duration* of 24 hours can be used. RTCA Software will automatically calculate one parameter when the other one is adjusted for a fixed *Interval* value.

### 4.1.2 Change the Preset Schedule of a Step

To change the schedule of a step, click the step in the table or click the Step icon, then move the cursor to the text boxes and make the changes. To confirm the changes, click the *Apply* button. The new settings will appear in the table.

### 4.1.3 Total Time

The *Total Time* column in the schedule table indicates the estimated total time needed for the experiment to reach a step/substep. Clicking on the *Total Time* heading in the table will cause that column to display Finish At, which indicates the time at which a step/substep will finish.
The specific times provided for Total Time and the Finish At are estimates only. The actual time may be different when:

► Pause / Continue / Abort a step (substep) is selected during the run
► A step or substep is added / deleted
► Sweeps / Intervals are changed
► Intervals assigned to step or substep are too short, for example: 1 second interval is assigned to Steps / Substeps

4.2 **Delete Steps**

To delete a step, click the step icon and then click the button. You can also use the Steps drop-down menu or right-click for a pop-up menu and select *Delete a Step*.

4.3 **Insert Steps**

To insert a step, click the Step icon below which you want to insert a new step (e.g., click Step 2 if you want to insert a step between Step 2 and 3), then go to the Steps menu and select *Add a Step*.

The newly inserted step will be named *Step_X*. The user can change the given name.

The steps below the inserted step are automatically moved down and the number of each step is reassigned consequentially.
4.4 Set up a Background Step

⚠ You must set up a background or reference step (i.e., step 1) before setting up any other experiment steps. The background step must be performed when each well of the E-Plate contains only tissue culture media, that is, before cells are added. The RTCA Software always reserves the first step (step 1) for background or reference data collection.

When a user adds the first step in the Schedule page, RTCA Software automatically sets its Sweeps to be 1, Interval be 1 minute. This is the setting required for a background step. The user should not change this setting except for Resistor Plate Verification (see RTCA Instrument Operator’s Manual).

💡 It is recommended to add an extra step at the end of the experiment when setting experiment schedule. This will ensure that, when the Software finishes the last experimental step, it will idle, waiting for manual intervention. The user can then determine (e.g., on the next morning) whether the experiment can be terminated or needs to be continued.

4.5 Saving Set-up(s)

As described above, the RTCA Software allows users to edit/enter various experimental set-ups. If they use a particular set-up frequently, users should save the information for that set-up, so it can rapidly be loaded into the RTCA Software each time a similar experiment is performed.

💡 The RTCA Software automatically saves all set-up information when the experiment starts. The user does not need to manually save such information, unless they wish to save it to be “re-used” in future experiments.

There are three parts of a set-up that the RTCA Software can save: Exp Notes, Layout and Schedule.

Once they enter or change the settings, users can save all the set-up information as a template file for later use, referred to as a Clone. To create a template, launch the RTCA Software, edit one or more pages (Exp Notes, Layout, and/or Schedule), then click the Save Changes button to save the settings on the edited page(s). A Save As dialog will appear:
Opening a Template (Clone Settings)

The default file name is “TemplateYYMMDD” for SP, TemplateYYMMDDPx” for MP (x is the plate number: 1 to 6), TemplateYYMMDDDx for DP (x is DP pattern number: 0 to 3. Refer to Section 15 for details), and TemplateYYMMDDTx for TP (x is TP pattern number: 0 to 3. Refer to Section 15 for details). The user can change the template file name, as appropriate. The template file contains all the information added to the Exp Notes, Layout, and/or Schedule pages.

4.6 Opening a Template (Clone Settings)

The user can open a previously saved template or clone the experiment setup from a previously-run experiment by selecting Setup from the main menu and choosing Clone Individual Page or Clone Experiment. A dialog box will appear. The user can navigate to the previously saved directory to open or clone from the saved template(s).

If Clone Individual Page is used, only the designated page is cloned from the selected template or experiment. Thus, the user can create a new experiment by cloning the different pages (Exp Notes, Layout, or Schedule) from up to 3 different templates and/or previously-run experiments.

If Clone Experiment is used, all three experiment setting pages (Exp Notes, Layout, and Schedule) will be cloned from a given template or an experiment file from a previously-run experiment.

Clone Individual Page or Clone Experiment will load only the experiment settings, so a new experiment can be run. Data in the previously-run experiment file are not loaded or changed.
5. Start an Experiment

5.1 Scan Plate

5.1.1 Manual Scan Plate

When a well has been activated in the Layout page, the Scan Plate icon in the tool and the "Scan Plate" from "Execute" menu will become active. When the Scan Plate function is initialized, the Software measures the resistance of each of the defined wells. This will verify that the proper connections are made between the E-Plate 96 and the RTCA SP Station.

The Scan Plate button is disabled when the RTCA Analyzer is performing the measurement.

The Message page will display the results of the scan and indicate any connection problems by listing the specific wells whose contact resistance is out of normal range. Each time when Scan Plate function is activated (either before or during the experiment), it will be recorded in the Message Page.

If the experiment has not started, the scan data are saved in:

C:\Users\Public\RTCA Data \Username\ScanPlateData

The Software creates the file name in the following format:

PlateScanningYYMMDD.txt (SP)

PlateScanningYYMMDDPx.txt (MP, x = 1 to 6)

PlateScanningYYMMDDX.txt (DP, x = 0 to 3)

PlateScanningYYMMDTX.txt (TP, x = 0 to 3)

If more than one scan is performed on the same day, all scan data made during that day will be saved in one file. The new scan data will be appended to the end of the existing scan data file.

At the beginning of an experiment, the data from the last 10 scans will be saved, together with the experiment data in the experiment *.plt file. After that, all new scan data will be saved in the experiment *.plt file.

5.1.2 Automatic Scan Plate

To facilitate monitoring of the E-Plate connection to the RTCA Station, the RTCA Software has a built-in scan function. Each time it detects an E-Plate being placed on the RTCA Station, the Software will automatically perform a Scan Plate measurement. The scan data will be saved and can be viewed in the same way as scan plate data generated manually.
5.1.3 **Check System**

If there is a connection warning shown in the *Message* page, and you want to determine whether it is a device problem or a RTCA Contact Pin (system) issue, you can use the *Check System* function. To do this, insert a Resistor Plate into the cradle, and click *Check System* from *Scan* drop-down list. The RTCA Software will perform a resistor scan. The check result will be shown at both the *Cell Index* page and the *Message* page.

![Check System Image]

5.2 **Example of Results from Scan Plate**

The *Cell Index* page shows the resistance values for all scanned wells.

![Cell Index Image]

The *Message* page will report that the *Scan Plate* function was used, and that the result was recorded as “Plate Scanned. Connections ok”.

![Message Image]
However, if the resistance value of a well is higher than 500 ohms, the Message page will report that this well may have a connection problem.

The following figure displays an example of a plate scan where potential connection problems are found using the Scan Plate function.

5.3 How to Handle Connection Issues

For detailed instructions on resolving E-Plate 96 (used with SP and MP Instruments), E-Plate 16 (used with DP and TP Instruments) or CIM-Plate 16 (used with DP Instrument), please refer to your specific RTCA SP, MP, DP or TP Instrument Operator’s Manual, under the section in ‘Maintenance and Care’, on cleaning and exchanging the RTCA Contact Pins.

5.4 Start Measurement

The Layout page and Schedule page must be set up before the experiment can be started. Once these two pages have been set, the button in the upper left corner becomes active. Click on the button to start the experiment.

The Step Status on the Schedule page shows the individual status of the steps included in the experiment. The status can be IDLE (indicates that the step has not started yet), TEST (step is in progress) or DONE (step is finished).
Check cable connections before starting the experiment to ensure that all plugs and cables of the RTCA Instrument are securely connected.

The RTCA Instrument will initiate measurements automatically, starting from the first step.

When the experiment starts, the Software measures the background first. Please do not remove the E-Plate while the Software is measuring the background. Otherwise, the experiment result will be incorrect.

5.5 Continue the Experiment

If the experiment is accidentally terminated (or after the experiment has been manually paused by the user, see below), the experiment can be resumed. To resume the experiment, launch the Software, go to File menu and select Open. Select the original experiment file of the accidentally terminated experiment and click the Open button. After the Software has successfully loaded the experiment, the button will become the Continue button, when there are any unfinished steps left to run. The RTCA Instrument automatically continues the measurement and performs calculations using the original background data. The new data is appended to the original experiment file. Neither experiment file name, nor experiment ID, nor the file location will be changed.

Do not use this function if the experiment was terminated before the initial background measurement was completed. When this is the case, always set up the experiment again from the beginning.

5.6 Pause the Experiment

After an experiment is started and as long as a step has not finished, the button automatically changes into the button. Click the button to pause the current unfinished step (and the whole experiment). All experimental data is automatically saved in the experiment file as a sweep measurement is performed. Thus, the user does not need to save the experiment file before pausing the experiment.

Pause temporarily stops a step, so the user can perform actions, such as adding compounds, checking connections, etc. without data being collected. After that, the user can resume the experiment and complete the remaining sweeps of the paused step.

After the user has clicked the button, the button will automatically change into a Continue button. This indicates that the RTCA Instrument is ready to resume the experiment. Once the user clicks Continue button, the button automatically changes back into a button, making it possible to pause the experiment again.

5.7 Start a Step

After a step is finished, it can directly start the next step if the Auto checkbox is selected. If the Auto checkbox is not selected for this step, the RTCA Instrument will stay IDLE to wait for the user’s interaction. In this case, the button will become active. In order to start the next step, click the button, and the system will initiate the next step.
5.8 **Abort a Step**

To terminate the current step, click the **Abort Step** button. You can terminate the current step and initiate the next step at any time depending on your experimental requirements.

*Abort Step stops the current step and discards the unfinished (remaining) sweeps of this step. Therefore, the user cannot resume this step. To continue the experiment, you must manually start the next step, if there is one.*

*Aborting a step does NOT lead to invalidation or loss of data.*

5.9 **Monitoring the Current Experiment Status**

The status bar on the bottom of the Software states the current status of the run. It will report one of the following messages:

- **Ready** (before the start of an experiment)
- **Ready for starting next step** (waiting to start the next step after completing a step)
- **Test sweep # of step #** (while the RTCA Instrument is performing a sweep measurement)
- **Waiting for sweep # of step #** (waiting for the start of the next sweep)

During a sweep measurement, a portion of the status bar will display **Test Col #** (the column number that is being measured). Between sweeps, a portion of the status bar will count down the time before start of the next sweep.
6. **Monitor an Experiment in Cell Index Page**

Real-time resistance measurement data will be recorded and presented with a unitless parameter called *Cell Index*. There are three cell indices taken at different frequencies: Cell Index-I at 10 kHz, Cell Index-II at 25 kHz, and Cell Index-III at 50 kHz. The Cell Index is defined as follows:

Cell Index = \( \frac{(R_{tn} - R_{t0})}{F_i} \)

Where:

i = 1, 2, or 3;

\( F_1 = 15\Omega, F_2 = 12\Omega, F_3 = 10\Omega; \)

and \( n = 0, 1, 2, \ldots, N \) (time points)

- \( R_{t0} \) is the background resistance measured at time point \( T_0 \), \( R_{tn} \) is the resistance measured at a time point \( T_n \).

- All 3-Frequency or any one of them can be selected for SP, MP or DP instrument. But only 10kHz is available for TP instrument.

Cell Index page archives the Cell Index for all the finished Sweeps of the experiment in Cell Index Table, and the Raw Scan Data and Background Data in Raw Scan Data and Background Data Table.

---

### 6.1 Cell Index Table

There is one drop-down lists in the Cell Index table. The *Time* drop-down list allows you to select the time point at which one Sweep was started during an experiment. Calculated Cell Index will be displayed in the Cell Index table for the selected wells in the Layout page.

When an experiment is running, the Cell Index table shows the most recent Cell Index obtained. To view previously collected data, select a particular measurement time point from the *Time* drop-down menu. If more than nine time points have been recorded, then use the scroll bar to view the hidden time points.
6.2 Scan Plate Data and Background Data Table

Raw Data Type drop-down list allows you to toggle between Raw Scan Data and Background Data to be displayed in the table.

**Raw Scan Data:**
Measured resistance data of all 96 wells (or 16/32/48 wells for RTCA DP or RTCA TP Instrument) each time the Scan Plate function is performed.

⚠️ Compare these data to the scan plate results on the Message Page to confirm which wells, if any, may have connection issues.

⚠️ Raw Scan Data is also used for Resistor Plate Verification. For more information please refer to the RTCA Instrument Operator’s Manual.

🔍 If the Scan Plate function was performed more than once, click the arrow buttons in icon to switch through each Raw Scan Data.

**Background Data:**
Background resistance data for all 96 wells (or 16/32/48 wells for RTCA DP or RTCA TP Instrument) at time point 0.

⚠️ Check the background measurement message on the Message page, to discover which wells, if any, may have background problems.

6.3 Copy Cell Index Data and Raw Data

The Cell Index data and raw data (including Background Data and Raw Scan Data) can be copied and paste to a text file and spreadsheet. To do so, just select the Time you want to copy and paste in the Cell Index Table. If you want to copy the raw data as well, select either Raw Scan Data or Background Data from the Raw Data Type drop-down list and enable the Output Raw Data checkbox in the Raw Scan Data and Background Table. In the Plate window Menu, click Edit → Copy. The desired data at desired time are now ready to be pasted to a text file and spreadsheet.
7. Plot Experiment Data

The Plot page displays and analyzes the collected data. To plot experiment data from a single well, double-click the well button that represents the well position on the well map; the Chart Plot will display the curve for that well.

To display multiple data points on the chart, click on one well and drag the pointer across the desired selection of wells. (The selected wells turn dark blue.) Then, click the Add button. The experiment data collected from the selected wells will be displayed on the Chart Plot. Clicking the Add button will cause data from every well measured in the experiment to be plotted on the Chart Plot. (See section 7.5 for information on removing well data from the Chart Plot.)

7.1 Plot Selection

Use the options in this section to change the way plots of well data are displayed:

► **X-axis**: From this drop-down menu, select the parameter to be plotted on the X-axis of the Chart Plot.

► **Y-axis**: From this drop-down menu, select Cell Index, Normalized Cell Index or Delta Cell Index as the parameter to be plotted on the Y-axis.

If you select Normalized Cell Index, you must also choose a specific time point for normalizing the data. You can select this time point from the Normalization Time drop-down menu under Curve Options (section 7.2). (A suitable time point might be, e.g., the last time point before compound addition.) The Normalized Cell Index for all wells will be set to one (1) at the normalization time point.

Similarly, if you select Delta Cell Index, you must choose a Delta time from the Normalization Time drop-down menu (section 7.2). All Cell Index data at the Delta time will be shifted to a fixed value (called the T-refer Cell Index). By default, the T-refer Cell Index will be one (1) for all wells at the Delta time point. However, you can specify a different T-refer Cell Index value by using the box just below the Y-axis box. Note that you use the same input box (Normalize Time) to select both the Delta Time and the Normalization Time.

► **Curve Style**: A user can choose to have data plotted on a Linear (default) or Log scale by clicking one of the radio buttons. Then, the curves will automatically use this scale on the Chart Plot.
Plot Selection

► **Line Marker Size:** Users can change the line size used on the plots. To do this, first click the button(s) on the well map corresponding to the well(s) you want to plot (selected well or wells will turn dark blue). Once the wells are selected, go to the Line Marker Size box and enter a smaller or larger value than is currently displayed. Smaller numbers will make the lines appear thinner and larger numbers will make the lines appear thicker.

► **Line Marker Style:** Users can change the type of symbol used to represent data on the plot. To do this, first click the button(s) on the well map corresponding to the well(s) you want to plot (selected well or wells will turn dark blue). Once the wells are selected, select the symbol from the Line Marker Style drop-down menu.

Example of Plotting Curve Data

Notice that the dark blue color of well buttons D1, D3, D5, D7, D9 and D11 in the well map indicates that these wells have been selected.

![Image of a well map with selected wells and corresponding curves on a chart plot.](image)

Clicking button displays the Cell Index curves for the six selected wells. (Note that the colors of the selected wells have changed to match the colors of the corresponding curves on the Chart Plot.)

![Image of Cell Index curves for selected wells.](image)
7.2 Curve Options

Use the drop-down menus in this section to change the type of data displayed:

► **Normalize Time:** This drop-down menu is not always available. It is only available when users select **Normalized Cell Index** or **Delta Cell Index** for the Y-axis (see Y-axis in section 7.1 above). In those cases, this drop-down menu displays all time points at which experiment data have been collected. Any time point selected in the drop-down menu will then be used as the normalization or delta time.

► **Cell Type:** If the experiment involves more than one type of cell, this menu lets users view data from a particular cell type (The different types must first be listed on the **Layout** page).

► **Cell Number:** If the experiment involves different numbers of cells, this menu lets users view data from a specific number of cells (as listed on **Layout** page).

► **Compound:** If multiple compounds were tested, this menu lets users view data generated from a particular compound (as listed on **Layout** page).

► **Concentration:** If multiple concentrations of a compound were used, this menu lets users view data generated from a particular concentration (as listed on **Layout** page).

7.3 Scale

Use the options in this section to change the range of data displayed:

► **Steps:** If the experiment consists of multiple steps, this function will facilitate viewing of only a few of those steps. For example, to view data from step 2 through step 5, first select **Steps** from the **X** menu, and then select 2 on the **From** menu and 5 on the **To** menu.

► **Time:** This function will facilitate viewing data recorded over a certain period of time. For example, to view data recorded from 2 hours, 10 minutes, to 5 hours, 30 minutes of the experiment, first select **Time** from the **X** menu, and then select 02:10:00 on the **From** menu and 05:30:00 on the **To** menu.

Choices are limited to the actual time points (hh:mm:ss) of measurement sweeps.

► **Full X scale:** Use this button to undo the **Steps** or **Time** selections (above) and restore the full range of data (i.e., display all the data points on the Chart Plot).

► **Auto Y:** Placing a checkmark in the **AutoY** box turns the auto-scaling function on and lets the software choose the best Y-axis for data display. To turn this function off, click on the box, and the checkmark will be removed.

Turning the auto-scaling function off will activate the **From** and **To** boxes below the **AutoY** box, allowing users to manually set the Y-axis scale. (Either use the up or down arrows next to these boxes, or type in numbers to set the desired Y-axis scale.)
7.4 Curve Color Selections

By default, if you click << Add or Add All, the curves will be drawn in colors that the system selects. To select different colors for each curve, use the Set Well Color button. All selected colors will be recorded in the experiment file so that, when the user logs-in the next time, the same colors will be used.

The color drop-down list above the Set Well Color button is used to select plot colors. To change the color of a specific curve, first select the well button on the Well Map by clicking on it (the selected well will turn dark blue). Then, choose the desired color from the color drop-down list and click Set Well Color to apply that color to the well data plot.

► Set Well Color: Click this button to change the color used to plot well data.
► Reset Well Color: Click this button to return plot colors to their default settings.

7.5 Other Function Buttons

► Average: If some data plotted on the chart are replicates (as defined in the Layout page), checking the Average box causes an average of these replicates to be plotted.
► STD DEV: Checking the STD DEV box adds error bars to any averaged data plotted on the Chart Plot (see section 7.8).
► <<Add: Once a well button or buttons are selected, clicking the <<Add button will plot the data from the selected wells on the Chart Plot (See also section 7).
► Add All: Clicking the Add All button will cause data from every well measured in the experiment to be plotted on the Chart Plot.
► Remove>>: Once a well button or buttons are selected, the Remove>> button removes the corresponding curves from the Chart Plot.
► Remove all: Clicking the Remove all button will remove all the curves from the Chart Plot.
7.6 Well Map

On the Plot page, the well map is used to select the well or wells whose curves will be displayed on the Chart Plot. Select an individual well by simply clicking on the well button. Select multiple wells by clicking and dragging across the desired well buttons. Individual wells can also be double-clicked to add data for that well to the Chart Plot.

The light grey color of wells on the well map indicates that these wells have been activated on the Layout page for this experiment.

7.7 Example of Adding Wells to the Chart

In the example below, wells have been selected for graphical display, but the << Add button has not been clicked yet.

After the << Add button is clicked, each well is represented by a colored line on the Chart Plot:
### 7.8 Example of the Average Function

The *Average* function calculates the average of replicate wells (i.e., wells with the same cell type, cell number, compound name and concentration on the *Layout* page) at each time point and displays the averaged data in a single color. The same color is used to highlight the replicate wells on the well map. The *STD DEV* function adds error bars (representing standard deviation the Software calculates for the average) to the graph.

![Average Function Example](chart.png)

### 7.9 Example of the Log Scale

The data below is displayed on a chart with a logarithmic Y-axis. To redraw a plot this way, select the *Log* button (in *Axis Scale*).

![Log Scale Example](chart.png)

### 7.10 Zoom In/Zoom Out

Click the left mouse button, then drag the cursor to draw a rectangle around an area on the plot. When you release the button, the curve within this area will be zoomed in (magnified). Press the *Esc* key to zoom out (return the plot to its original scale).

![Zoom In/Zoom Out Example](chart.png)
Before **Zoom In:**

![Before Zoom In Image]

**Zoom In** may take a longer time when there are a lot of data points in the area selected for zooming.

After **Zoom In:**

![After Zoom In Image]

7.11 **Curve Repair Function**

If for any reason the experimental curve is not smooth (most likely due to poor RTCA Contact Pin connections that occurred when a plate was taken out and re-engaged during an experiment), the RTCA Software offers Curve Adjustment Tools for repairing those problem curves.

- **Curve Adjustment Tools** are not available when an experiment is running. Curve repair must be done only after the experiment has finished or paused.

- Always back up the original experiment data file (*.plt) before repairing the problem curves.

- **Curve Adjustment Tools** are available only when Cell Index data is plotted on the Y-axis. After curve adjustment, the user can plot Normalized Cell Index or Delta Cell Index based on the adjusted Cell Index data.
To repair problematic curves, select Curve Adjustment Tools from the Setup menu.

Curves before adjustment:

After Curve Adjustment Tools is selected, the Adjust peak panel will appear in the bottom-left corner. Two types of curve adjustment tools are offered, **Shift** and **Line fit**.

### 7.11.1 Shift of Curves

To shift curves, follow these steps:

- Select curve(s) to be shifted by selecting wells from the well map and adding their curves to the plot.
- Select the time range over which to shift curve(s), using the time drop-down menu to set the **From** and **To** time points.
- Type in the value (positive or negative) by which the curves will be shifted.
- Choose the **Shift** button.
- Click the **Adjust Curve** button.

After the **Shift** adjustment, all the curves in the selected time range will be shifted by the **Shift** value.

**Example**: The curves have been shifted by -0.2 for all time points between 22:30:34 and 23:23:22.
7.11.2 **Line Fit**

To do a *Line fit*, follow these steps:

► Select curve(s) to be adjusted by selecting wells from the well map, and adding their curves to the plot.

► Select the time range over which to fit curve(s), using the time drop-down menu to set the *From* and *To* time points.

► Choose the *Line fit* button.

► Click the *Adjust Curve* button.

After the *Line fit*, the portion of each curve within the selected time range becomes a smooth line.

Example: The portion of the curves between 22:30:34 and 23:23:22 are adjusted with a line fit.

---

### Baseline Cell Index

Users can choose one or more curve(s) as a **baseline** (if more than one curve is given, the average Cell Index of the given curves will be used as the baseline). Once a baseline is chosen, all points on the data curves will be calculated by subtracting the baseline Cell Index from the original Cell Index, *i.e.***:

\[
CI_{\text{new}} = CI_{\text{original}} - CI_{\text{baseline}}
\]

The Y-axis of the plot is now labeled **BaseLine Cell Index** (*BaseLine Normalized Cell Index*, or *BaseLine Delta Cell Index*).
Follow these steps to draw a Baseline Cell Index curve:

► On the well map, select a well or wells to be used as baseline wells.
► Click the Add BaseLine button (the selected well(s) will be shown in the BaseLine Well ID box).
► Select the well(s) to be plotted on the well map.
► Click the << Add button to add curves to the plot. The Y-axis will be labeled BaseLine Cell Index.

Click Reset BaseLine to remove the baseline and to restore plots of actual Cell Index values.

**Example:** Six wells are selected (D1, E1, D3, E3, D5 and E5) and displayed without and with D1 as a baseline well.

Cell Index curves are plotted for D1, E1, D3, E3, D5 and E5 wells.

BaseLine Cell Index curves are plotted for D1, E1, D3, E3, D5 and E5, with D1 well as baseline well.
7.13 Normalized Cell Index

For each well, the Normalized Cell Index (NCI) is calculated as the Cell Index $CI_{ti}$ at a given time point divided by the Cell Index $CI_{nml\_time}$ at the normalization time point (nml_time), as below:

$$NCI_{ti} = \frac{CI_{ti}}{CI_{nml\_time}}$$

Thus, the Normalized Cell Index for all wells must equal one (1) at the normalization time point.

Normalized Cell Index is only effective for RTCA mode.

Follow this procedure to plot the Normalized Cell Index:

▸ Select Normalized Cell Index from the Y-Axis drop-down list.
▸ Select well(s) on the well map.
▸ Click the << Add button to draw the Normalized Cell Index curve(s).
▸ Select a Normalization time point from the Normalize Time drop-down menu.

Example: Normalized Cell Index plot for wells D1, E1, F1. Normalize Time is 23:05:24.

7.14 Delta Cell Index

For each well, the Delta Cell Index (DCI) is calculated as the Cell Index $CI_{ti}$ at a given time point plus a Delta value. The Delta value is a constant value for each well and is the difference between a reference DCI value and the Cell Index at the Delta Time point, as below:

$$DCI_{ti} = CI_{ti} + (DCI_{reference} - CI_{Delta\_time})$$

Thus, the Delta Cell Index for all the wells is the reference DCI value at the Delta time point. The default value of the CI at Ref. Time is one (1), but the user can change that value.
Follow this procedure to plot the *Delta Cell Index*:

- Select *Delta Cell Index* from Y-Axis drop-down list.
- Select well(s) on the well map.
- Click the <<Add button to draw the *Delta Cell Index* curve(s).
- Select Delta time point from the *Delta Time* drop-down list (the same list as the Normalize Time list).
- Put in the required Reference DCI by typing in the value in the *CI at Ref. Time* box.

**Example:** Delta Cell Index plot for wells H1, I1, H13, and I13; Delta Time point is 23:41:57 and DCI reference = 3.0.

### 7.15 Settings for Data Analysis

In the *Settings* of the *Data Analysis* section of the *Plot* page, the user can set up some parameters for the *Data Analysis* page, including curve type and time period to analyze. The options in *Settings for Data Analysis* section are the same as those under IC\textsubscript{50} Option on the *Data Analysis* page. For more details, refer to section 10.2.4, Curve Types and Curve-Fit Formula.
8. Copying Experiment Data

8.1 Copy Experiment Data to Microsoft Excel

There are two ways to export data to Microsoft Excel.

First, launch the RTCA Software and open the experiment data file (*.plt), then:

► Go to the Cell Index page and select a time point from the time drop-down menu. The Cell Index values at the selected time point will be shown. Select Copy from the Edit menu. The Cell Index values will be copied and ready for pasting into an Excel worksheet. Open Microsoft Excel and select Paste from the Edit drop-down menu to paste the copied data to Microsoft Excel.

► Go to the Plot page, select the wells to be analyzed on the well map and click << Add to display curves for the selected wells. Once the curves are displayed, right-click the mouse, and select Copy Data in List Format from the pop-up menu. The data on the chart will be copied (as a list of data points) and ready for pasting to an Excel worksheet. Open Microsoft Excel and select Paste from the Edit drop-down menu, to paste the copied data to Microsoft Excel.

8.2 Copy Graphic Charts or Data on Charts

To copy graphic charts or data on charts to Microsoft PowerPoint, Microsoft Word or Microsoft Excel, follow these steps:

► Launch the RTCA Software and open the experiment data file (*.plt).
► Add the desired curves to the Chart Plot.
► Point the cursor at the Chart Plot and right-click the mouse.
► Select Copy Charts (or other items) from the pop-up menu.
► Open the program (typically Microsoft Word/Excel/PowerPoint) to which you want to paste the chart or data from the chart.
► Select Paste on the Edit drop-down menu.

The charts are imported as pictures. Therefore, their curves and labels cannot be modified. If the chart is to be modified, use the Copy Data from Chart function to paste the data into Microsoft Excel (or other data analysis software), then use Microsoft Excel’s graphing function to re-plot the data.
8.3 Example of a Right-Click Menu

On the Plot page, right-clicking the mouse will open a menu with the following options:

- **Copy Charts**: Copy the chart as a picture.
- **Copy Well Selection Map**: Copy the well map.
- **Copy Layout Information**: Copy all layout information for the selected wells.
- **Copy Data in List Format**: Copy (as a simple list) the Cell Indexes for the selected wells and for time points currently displayed on chart.
- **Copy Data in Matrix Format**: Copy (as a matrix) the Cell Indexes for the selected wells and for time points currently displayed on chart.

After clicking one of the menu items described above, the user can go to Excel and paste the copied chart or all the copied data.
9. Well Graph

The Well Graph page provides an overview of Cell Index curves for all the wells by displaying them in 8×12 matrix format. The user can display and compare some of the curves in the Zoom Area (top-right part of page) by just clicking on the wells to be compared. The user can also select one of the wells as a reference.

The Well Graph display is only effective for RTCA mode.

9.1 User Interface

The Well Graph Page is divided into four main areas: Well Graph, Zoom Area, Graph Setting and Summary.

9.2 Well Graph Display

If there is Cell Index data in the experiment that is currently open, all the Cell Index curves will be displayed on the Well Graph. If any data is added or modified during or after the experiment, the curves on this display will automatically be updated in real time.

The following figure is an example of a Well Graph display during an experiment.
9.3 Zoom Area

The Zoom Area can display expanded versions of curves that the user selects from the Well Graph. To select one or more well curves to display in the Zoom Area, simply click the corresponding wells on the Well Graph. The color of the chosen well(s) will change to white. To remove a curve from the Zoom Area, just click again and the color of this well will change to the original. To clear all the added curves from the Zoom Area, click the Clear button.

The following figure is an example of a Zoom Area display.

Users can also choose one of the curves on the Well Graph as a reference. Once a reference curve is chosen, the curves in the Zoom Area will be calculated by subtracting the reference Cell Index from the original Cell Index, i.e.:

\[ \text{CI}_{\text{new}} = \text{CI}_{\text{original}} - \text{CI}_{\text{Reference}} \]

Follow these steps to draw a Reference Cell Index curve:

- Move the mouse cursor to the well that you want to set as a reference
- Right-click the mouse. The select reference well will turn to yellow. This reference well ID will also show in Baseline Well ID in the Summary area of the well graph.
- Add other wells to the Zoom Area by clicking them.

The following figure is an example of reference curves.

In the above figure, well A12 has been selected as a reference, so the wells (i.e., H1, H2, H3) added to the Zoom Area are plotted as Reference Cell Index lines.
9.4 Graph Setting

Users can adjust the setting for Well Graph and Zoom Area by using the functions in the Graph Setting area.

► Auto Scale:
Automatically adjust the Y-axis of the Well Graph by the software. De-selecting Auto Scale allows users to adjust the Y-axis scale manually. Typing numbers in the boxes of Cell Index Cap and Cell Index Bottom set the upper and lower limits of the Y-axis for the Well Graph plot.

⚠ Please note that the value of Cell Index Bottom must be less than that of Cell Index Cap.

► Draw Baseline:
If a reference well is selected, select this Draw Baseline box will add the curve of the reference well to each of the Well Graph in order to make direct comparison to the reference well possible.

► From XXX to XXX:
Selection of the time period to plot the well graph.

9.5 Summary

There is a Summary area displaying information about the current experiment, including maximal Cell Index value and the corresponding well ID, minimal Cell Index value and the corresponding well ID. The following figure is an example of a summary.

In the above figure, the well that has the Maximal Cell Index is A6, and its value is 9.2406, and the well that has the Minimal Cell Index is C6, and its value is -0.0158.
10. **Data Analysis**

The *Data Analysis* Page is used to analyze data obtained by the RTCA Instrument and to calculate relevant parameters for cell-based assays.

The *Data Analysis* Page is divided into four main areas: Tool Bar, Graph Plot, Data Analysis Settings and Result Summary Table.

10.1 **Tool Bar Button Definitions**

10.1.1 **Draw Curve, Add Curve and Clear Curve**

Four buttons ![Draw a New Curve](image) in the tool bar are used to draw, add, remove and clear data analysis curves.

- **Draw a New Curve:** After the drawing parameters have been selected, clicking ![Draw a New Curve](image) will first clear all curves on the graph area, then draw the new curve.

- **Add a Curve:** After the drawing parameters have been selected, clicking ![Add a Curve](image) will add the curve(s) to the existing graph. This button is usually used for curve comparison.

- **Remove Last Curve:** Clicking ![Remove Last Curve](image) will remove the last curve added to the existing graph.

- **Clear Chart:** Clicking ![Clear Chart](image) will clear all the curves from the graph plot, as well as the corresponding data from the summary table.

10.1.2 **Copy Page, Copy Chart and Copy Data on Chart**

Three buttons ![Copy Page](image) are used to copy page, copy charts and data on the *Data Analysis* page to the Windows clipboard.

- **Copy Page:** Click ![Copy Page](image) will copy the page to the Windows clipboard, where they can be pasted to other application software, such as Microsoft Excel, Word, PowerPoint, etc.
10.2 Data Analysis Functions

The Data Analysis Page is used to analyze data obtained by the RTCA Instrument and to calculate relevant parameters for cell-based assays. Major functions include:

► Calculate and display IC\textsubscript{50}/EC\textsubscript{50} values for experimental data, when a series of compound concentrations is used. Various methods are used to derive IC\textsubscript{50}/EC\textsubscript{50} values.

► Calculate and display Cell Index Slope and Doubling Time within a given time period.

► Calculate and display time-dependent IC\textsubscript{50} values.

► Export Dose-Response Curves and other graphs to Microsoft Excel or Microsoft PowerPoint and other application software.

► Export curve-fit data to Microsoft Excel and other application software.

10.2.1 Experimental Data for Analysis

Data Analysis can be performed after opening any existing RTCA experiment data file. Follow these steps to load existing experiment data:

1. Click File → Open in the main menu.

2. Select the experiment file (.plt) from the Open File dialog.

3. Click Open to load the experiment data into the RTCA Software.

Depending on how often data is measured during an experiment, it is possible to perform data analysis when the experiment is still running.

- If data acquisition is infrequent (for example, time interval is every 30 minutes or more), then data analysis can be performed at the same time when the experiment is running.

- It is not advisable to perform data analysis during an experiment that is acquiring data very frequently (e.g., time interval is every 5 minutes or less). In this case, the on-line data analysis would use computer resources that are required for running the experiment.
10.2.2 Well Selection for Analysis

After loading a set of experiment data, go to the Plot page and select wells which will be used for data analysis.

For IC\textsubscript{50}/EC\textsubscript{50} calculation, selected wells must all contain the same compound (which must be listed on the Layout page). If the Layout page shows that the wells contain more than one type of compound, go to the Plot page and put a checkmark in the Compound box, then select the compound you want. Then, add the desired wells to the plot.

10.2.3 An Example of Data Analysis: Dose-Response Curve (DRC) at a Time Point

After selecting wells on the Plot page, go to the Data Analysis page. To obtain a dose-response curve at a single time point, select the following items:

1. Select RTCA mode.
2. Select DRC (CI at a time point vs conc) from the Curve Type drop-down list.
3. Choose Sigmoidal dose-response from the Formula drop-down list.
4. Select a single Time Point from the Time drop-down list.

Click \( \text{ or } \) on the tool bar. The graph will display a dose-response curve (X-axis: concentration; Y-axis: identical to the Y-axis shown on the Plot Page, e.g., Cell Index or Normalized Cell Index) with discrete points for selected wells. Furthermore, the RTCA Software uses the "sigmoidal dose-response equation" to apply curve-fitting to the experimental data points, and then calculates IC\textsubscript{50}/EC\textsubscript{50} values, as well as values for other parameters in the equation. The calculated IC\textsubscript{50}/EC\textsubscript{50} values are shown in the Result Summary Table on the right side of the Page.

- The number in the yellow box next to each curve provides the order of the curves that have been drawn/added to the graph area. This number is used to distinguish between different curves on the graph area. The details for each curve are shown next to the corresponding number in the Table.

- Not all information can be displayed in the Result Summary Table due to space limitations. There are tooltips available for each cell. If you want to see more information about each cell, just click on the respective cell. Then, a pop-up window containing information on the corresponding cell will open.

- If you have selected a user defined unit ("Ur Unit"), it is not possible to perform certain calculations on the Data Analysis page, such as DRCs. An error message will appear.

- Curve Types and Time period used for can be preselected in Settings for Data Analysis on the Plot page. There is a checkbox which allows user to choose a period of time for data analysis. By default, this box is unchecked. If this box is checked, a blue line (indicating the Starting Time) and a red line (indicating the ending time), will be shown on the Plot page. These lines represent the time period covered by the calculation. If the selected curve type is DRC at a time point, only the red line is shown, to indicate the time point selected on the Plot page.
You can either select the Stating Time and Ending Time by clicking the drop-down list or by simply dragging the blue line and red line by along the X-axis on the Chart Plot.

To show curve-fitting details, move the cursor close to the yellow box on the Graph Plot. The detailed information about formula, curve type, time point, and fitted parameters will be shown in a yellow box.

10.2.4 Curve Types and Curve-Fit Formula

10.2.4.1. Curve Types

There are eight built-in curve types available. Not all the eight curves will be suitable for a particular user with a specific assay, but one or more of them should be appropriate for a given application. Based on your experiment, you may choose one or more of the curves for your experimental data analysis.

<table>
<thead>
<tr>
<th>Group ID</th>
<th>Curve ID</th>
<th>Curve</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>1</td>
<td>Slope</td>
</tr>
<tr>
<td>2</td>
<td>2</td>
<td>Doubling time</td>
</tr>
<tr>
<td>3</td>
<td>3</td>
<td>Time dependent IC\textsubscript{50}</td>
</tr>
<tr>
<td>4 DRCs</td>
<td>4</td>
<td>DRC (CI at a time point vs conc)</td>
</tr>
<tr>
<td>5</td>
<td>5</td>
<td>DRC (max CI in a time period vs conc)</td>
</tr>
<tr>
<td>6</td>
<td>6</td>
<td>DRC (min CI in a time period vs conc)</td>
</tr>
<tr>
<td>7</td>
<td>7</td>
<td>DRC ((max-min) CI in a time period vs conc)</td>
</tr>
<tr>
<td>8</td>
<td>8</td>
<td>DRC (area-under-curve in a time period vs conc)</td>
</tr>
</tbody>
</table>

All calculations and curve-fitting on the Data Analysis page are performed using Cell Index or Normalized Cell Index or Delta Cell Index values identical to those displayed on the Y-axis on the Plot page. For example, if Normalized Cell Index is selected as the Y-axis on the Plot page, all calculations will use Normalized Cell Index values.

Curve Types and Time Period can be preselected in the Settings for Data Analysis on the Plot page.
Data Analysis
Data Analysis Functions

► **Slope:**

The **Slope** is used to describe the steepness, incline, gradient, or changing rate of a curve within the given time window. The **Slope** parameter may be used for cell proliferation, cell adhesion, cytotoxicity, receptor activation or other cell-based assays. For example, if one is interested in the rate of change of the Cell Index for cells after cytotoxic compound treatment, then Slope could be chosen for such analysis.

For each selected well, the Software calculates the Slope of the Cell Index (or Normalized Cell Index, or Delta Cell Index) curve in the chosen **Time** period, after fitting the points to a straight line. The slope values are shown in the bar chart. Please see the example illustrated in the screenshot below:

![Slope Example Screenshot]

► **Doubling Time:**

The **Doubling Time** is used to describe the period of time required for a curve Cell Index value to double or to be half ("half" only if the slope of the curve is negative within the selected time period). The **Doubling Time** parameter may be used for cell proliferation and other cell-based assays. For example, if one is interested in how the Cell Index changes during the log-growth phase of cells in E-Plate, the Doubling-Time can be used for such analysis.

For each selected well, the Software calculates the doubling-time for the Cell Index (or Normalized Cell Index) in the chosen time period, by fitting the curve to an exponential equation. The **doubling time** is the time required for the Cell Index (or Normalized Cell Index) to double, based on the curve-fit. If the doubling time is negative, it means that Cell Index (or Normalized Cell Index) decreases with time. In this case, the doubling time is the time required for Cell Index (or Normalized Cell Index) to halve, based on the curve-fit. The calculated Cell Index Doubling Time values are shown in the bar chart. Please see the example illustrated in the screenshot below:

![Doubling Time Example Screenshot]
**Time Dependent IC\textsubscript{50}:**

The **Time Dependent IC\textsubscript{50}** describes how the IC\textsubscript{50} changes within a given time period following a compound treatment. While end-point assays can only provide a single IC\textsubscript{50} value, the calculation of the **Time dependent IC\textsubscript{50}** is one of the important features of RTCA Instrument, allowing the user to determine and derive the kinetic dependency parameter for compound effectiveness and potency. The **Time-dependent IC\textsubscript{50}** is used in cell-based assays, when compound treatment has been performed on the cells in multiple wells and at different concentrations. Applicable cell-based assays include compound-induced cytotoxicity, compound-effected cell adhesion, receptor-activation and many other compound-added assays.

To calculate the Time-dependent IC\textsubscript{50} the Software automatically extracts 20 time points within the chosen time period, calculates the IC\textsubscript{50}/EC\textsubscript{50} values at each of these points, and then draws a curve showing the time-dependence of IC\textsubscript{50} or EC\textsubscript{50} values (X-axis: time point; Y-axis: IC\textsubscript{50}/EC\textsubscript{50} values). If there are fewer than 20 time points in the chosen period, then IC\textsubscript{50} values for all the points will be calculated. Please see the example in the screenshot illustrated below:
Data Analysis

Data Analysis Functions

Dose-Response Curve (DRC):

The Dose Response Curve is derived from Cell Index values of a group of wells (at least 3), which have the same compound treatment, but differ in concentrations. It reflects the dependency of the Cell Index Responses on the compound concentrations.

There are various methods for deriving the DRC, although the X-axis of the DRC is always the compound concentration. The RTCA Instrument carries out kinetic measurements, and the derived Cell Index or Normalized Cell Index parameters are always time-dependent. Thus, the most straightforward method in deriving DRC is the choice of Cell Index at a time point after compound treatment as the Y-axis parameter. This is the most widely used option for calculating the DRC when analyzing RTCA data.

There are however additional ways to analyze RTCA data to produce DRC curves based on other methods, such as Max Cell Index or Minimum Cell Index or Difference Cell Index or Area Under the Curve, within a given time period. Which analysis curve method to use is a function associated with the goals of the assays being performed and the preference of the user. For example, if the compound treatment results in cell morphological changes in a concentration-dependent and time-dependent manner, the user may be interested in the maximum alteration of cell morphology within a time period of compound treatment. In such a situation, one can choose Max Cell Index or Minimum Cell Index as the Y-axis parameter for DRC curves, depending on whether compound-induced cell morphology change corresponds to an increase or decrease in Cell Index. In other assays, the user may be interested in the overall effect of the compound treatment for a given time period. Under such cases, Area-under-the-Curve can be chosen for analyzing the RTCA data.

While different types of DRCs can be used for analyzing data from any cell-based assays where compound treatment has been performed, the exact choice for the appropriate type of DRCs will depend on the assay type, assay condition and most importantly, what the user is interested in achieving in such assays. The following table summarizes the commonly used DRC curve types for different cell-based assays.

The curve types listed below are not intended to provide all possibilities but rather to provide examples for how one could choose a specific DRC curve type for the data analysis of a given assay type.

<table>
<thead>
<tr>
<th>Assay Type</th>
<th>Commonly used DRC type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cytotoxicity</td>
<td>DRC (CI at a time point vs conc),</td>
</tr>
<tr>
<td></td>
<td>DRC (area-under-curve in a time period vs. conc)</td>
</tr>
<tr>
<td>Receptor Activation</td>
<td>Max (peak) Cell Index (Normalized CI, or Delta CI) within a</td>
</tr>
<tr>
<td></td>
<td>selected time period</td>
</tr>
<tr>
<td></td>
<td>Min (bottom) Cell Index (Normalized CI, or Delta CI) within a</td>
</tr>
<tr>
<td></td>
<td>selected time period</td>
</tr>
<tr>
<td></td>
<td>Difference (Max – Min) Cell Index (Normalized CI, or Delta CI)</td>
</tr>
<tr>
<td></td>
<td>within a selected time period</td>
</tr>
<tr>
<td>Cell Adhesion</td>
<td>DRC (CI at a time point vs. conc)</td>
</tr>
</tbody>
</table>

A DRC X-axis is always the compound concentration (from low to high); its Y-axis could be any value at a selected time point or period of:
Data Analysis

Data Analysis Functions

► Cell Index (Normalized CI, or Delta CI) at a selected time point
► Max (peak) Cell Index (Normalized CI, or Delta CI) within a selected time period
► Min (bottom) Cell Index (Normalized CI, or Delta CI) within a selected time period
► Difference (Max – Min) Cell Index (Normalized CI, or Delta CI) within a selected time period
► AUC (area-under-curve) of Cell Index (Normalized CI, or Delta CI) within a selected time period

► DRC (CI at a time point vs conc): Shows dose response curve [X-axis: compound concentration; Y-axis: Cell Index or Normalized Cell Index (same Y-axis as on Plot Page)] for all selected wells, and then uses the chosen formula to perform curve-fitting and calculate IC$_{50}$/EC$_{50}$ values at the chosen time point.

► DRC (max CI in a time period vs conc): Shows dose-response curve (X-axis: compound concentration; Y-axis: maximum of Cell Index or Normalized Cell Index in the chosen time period) for all selected wells, and then uses the chosen formula to perform curve-fitting and calculate IC$_{50}$/EC$_{50}$ values for that DRC.

► DRC (min CI in a time period vs conc): Shows dose-response curve (X-axis: compound concentration; Y-axis: minimum of Cell Index or Normalized Cell Index in the chosen time period) for all selected wells, and then uses the chosen formula to perform curve-fitting and calculate IC$_{50}$/EC$_{50}$ values for that DRC.

► DRC ((max - min) CI in a time period vs conc): Shows dose-response curve [X-axis: compound concentration; Y-axis: (maximum minus minimum) of Cell Index or Normalized Cell Index in the chosen time period] for all selected wells, and then uses the chosen formula to perform curve-fitting and calculate IC$_{50}$/EC$_{50}$ values for that DRC.

► DRC (area-under-curve in a time period vs conc): Shows dose-response curve (X-axis: compound concentration; Y-axis: area-under-curve for Cell Index or Normalized Cell Index in the chosen time period) for all selected wells, and then uses the chosen formula to perform curve-fitting and calculate IC$_{50}$/EC$_{50}$ values for that DRC.
10.2.4.2. Curve Fit Formula

There are two formulas available for calculating IC\textsubscript{50}/EC\textsubscript{50} values:

1. **Sigmoidal dose-response**
   \[ Y = \text{Bottom} + \frac{(\text{Top} - \text{Bottom})}{(1 + 10^{(\text{Log EC}_{50} - X)})} \]

2. **Sigmoidal dose-response** (Variable slope)
   \[ Y = \text{Bottom} + \frac{(\text{Top} - \text{Bottom})}{(1 + 10^{((\text{Log EC}_{50} - X) \cdot \text{HillSlope})})} \]

The above formulas use the EC\textsubscript{50} value for the calculation. For an IC\textsubscript{50} calculation, the same formulas can be used, except that IC\textsubscript{50} is used in place of EC\textsubscript{50}. Depending on specific applications, a user can choose to use either EC\textsubscript{50} or IC\textsubscript{50} in formulas by clicking one of the two radio buttons at the lower left of the Data Analysis page. If EC\textsubscript{50} is selected, then EC\textsubscript{50} will be used in the formulas, and the calculated results will be labeled EC\textsubscript{50} (for example, the sixth curve type would be called **Time Dependent EC\textsubscript{50}**).

The choice of EC\textsubscript{50} or IC\textsubscript{50} simply affects how the results are labeled and shown, but does not affect how the results are calculated.

10.2.5 Data Analysis on Averaged Data for Replicate Wells

The Data Analysis page can process averaged Cell Index or averaged Normalized Cell Index for replicate wells. On the Plot page, select the wells that have the same cell type and the same Compound Name (as listed on the Layout page). In addition, some of the selected wells must have exactly the same compound Concentration. Put a checkmark in the STD DEV box and click the Average button. A graph showing averaged Cell Index curves (or averaged Normalized Cell Index curves) with standard deviations will be displayed on the Plot page.

In the example below, the Software has calculated and plotted the data, including average and standard deviation for each time point, for the corresponding wells in column 2 and 3 (wells B1 to F1, B2 to F2). The Cell Index in normalized at the time point before compound is added (24:28:12).

Switch to the Data Analysis page and then select DRC (CI at a time point vs conc) from the Curve Type box. The software will plot a dose-response curve with standard deviation for each concentration point.
Please don’t use Standard Deviation function for the calculation of “Dose response curve (area-under-curve in a time period vs conc)”.

10.2.6 Compare Dose-Response Curves and Corresponding EC<sub>50</sub>/IC<sub>50</sub> Values for Selected Wells at Different Time Points

To compare DRC and corresponding EC<sub>50</sub>/IC<sub>50</sub> values at different time points:

1. Select wells on the Plot page.

2. Go to the Data Analysis page. Choose DRC (CI at a time point vs conc) from the Curve Type box. Then select a Time point. Click to draw the first curve.

3. Without altering the well selection or Curve Type, select another Time point. Click to add another curve.

4. If needed, Repeat step 3) to add more curves for comparison.

The IC<sub>50</sub>/EC<sub>50</sub> data is shown in the table on the right side of the Data Analysis Page. Please see the example in the screenshot illustrated below:
10.2.7  Compare Dose-Response Curves and Corresponding EC$_{50}$/IC$_{50}$ Values for Different Wells at the Same Time Point

To compare DRC and corresponding EC$_{50}$/IC$_{50}$ values for different wells at the same time point:

1. Select the first group of wells on the Plot page.

2. On the Data Analysis page, choose DRC at a time point as the Curve Type and then select a Time point. Click $\square$ to draw the first curve.

3. Select a second group of wells on the Plot page.

4. On the Data Analysis page, without altering the well selection or Time point, click $\square$ to add another curve.

5. If needed, repeat steps 3) and 4) to add more curves for comparison.

The IC$_{50}$/EC$_{50}$ data are shown in the table on the right side of the Page. Please see the example illustrated in the screenshot below:
10.2.8 Compare Cell Index Slopes (or Cell Index Doubling Times)

To compare Cell Index Slopes or Cell Index Doubling Times for the same group of wells in different time periods:

1. Select a group of wells on the Plot page.

2. On the Data Analysis page, choose Slope (or Doubling Time) as the Curve Type and then select the first set of Time points (beginning time and end time). Click to draw a bar chart that shows the slope.

3. On the Data Analysis page, without changing the Curve Type, select a second set of Time points (beginning time and end time). Click to add a new slope to the existing graph.

4. If needed, repeat step 3) to add more time-periods for comparison of slopes or doubling times.

See the following example in the screenshot below that shows a comparison of slopes:
11. Message Page

The Message page provides information that occurs before, during, and after the experiment. The recorded information includes the start and stop time of each step, the time the scan plate was performed at, the time the experiment was paused/resumed at, etc.

Additionally, the Message page lists errors that occurred during an experiment and were detected by the RTCA Instrument, along with error codes. Some error codes are related to the use of the instrument; for example, removal of the E-Plate from the RTCA Station in the middle of a sweep-measurement would result in an error. Users can fix these instrument-use errors. Other errors may relate to hardware issues. If such error codes persist, please contact your local ACEA representative.

All messages are listed in the message table. Use ▼ ◀ ▶ ▼ to navigate to a different message page, when there is more than one page of messages.

Each message contains three parts:

► Message Time:
When the message was recorded

► Message ID:
The unique ID to identify the message

All messages are divided into three categories, and start with a character “m” (ordinary message), “w” (warning), or “e” (error).

► Message Details:
Delivers detailed information on event

Warning message IDs are highlighted in yellow. Error message IDs are highlighted red.

The following screenshot shows a potential Message page appearing at the end of an experiment:
11.1 Warning Message Sign

During an experiment, if a warning was recorded, a warning sign ⚠️ is shown on the left corner of the Status Bar. Clicking on this ⚠️ sign, or clicking the Message tab will show the Message page with the warning, and the warning ⚠️ sign will disappear.

If you have wells with connection problems, please consult the RTCA Instrument Operator’s Manual to troubleshoot these problems.

Another warning message appears when the experiment is started, and there are wells with background problems. This message lists the wells which have background problems and helps the user in planning the layout for the experiment. If you have problem wells, please check the connection of the E-Plate and RTCA Station and follow recommendations for cleaning in the RTCA Instrument Operator’s Manual. If problems persist, contact your local ACEA representative. Please also send appropriate data files (please refer to the RTCA Instrument Operator’s Manual).

11.2 Error Message Sign

During an experiment, if there was an error recorded, an error sign 💩 is shown on the left corner of the Status Bar. Clicking on this 💩 sign, or clicking on the Message tab will show the Message page, and the error 💩 sign will disappear.

Please refer Troubleshooting section in RTCA Instrument Operator’s Manual for details to solve the problems if an error is observed.
12. Audit Trail Page

The Audit Trail page provides information about change history of experiment file after the experiment started, like update layout information, modify experiment notes, add a step, add or delete an analysis template, etc. Each record is one action that user did. Every action user did that would modify the experiment file will be recorded. All records are listed in time order from new to old.

Each record contains eight parts:

► ID: The unique ID of each record.
► Time: When did the user do the action.
► Computer: The name of the computer used for the experiment.
► SW Version: The software version that user used to do the action.
► User: The user that did the action.
► Action: The description of the action performed by the user.
   For example, ExpNotes. Purpose. Update means update the purpose of Exp Notes page.
► Old Value: The old value of the field before the action.
   Please note that not all actions have “Old Value”, like Schedule.AddStep.
► New Value: The new value of the field after the action.
   Please note that not all actions have “New Value”, like Schedule.DeleteStep.
13. **Experiment Reports**

13.1 **Create a Problem Report**

Whenever users want to contact ACEA representative for support (e.g., to solve recurring issues during an experiment), they must send a Problem Report file to allow precise assessment of the issue. To generate a Problem Report file, do the following steps:

► Launch the RTCA Software.
► Open the experiment file on which you want to report any issues.
► Open the Plate Menu and select Create Problem Report.
► A dialogue window pops up asking whether it is OK to save all the Exp Notes and Layout information to the problem report file. Click the Yes if there is no confidential information in the experiment. Click No to hide all the Cell Type and Compound information. Click Cancel if you do not want to create the report.
► After you select either Yes or No, the RTCA Software will create a Problem Report file with the file name Err_******.zip.

*The created problem report file (Err_******.zip) is located in the same folder of its original *.plt data file.*

**Example:** The dialogue window asks the user whether all Exp Notes and Layout information can be sent to Customer Support.

![Dialogue window](image)

**Example:** The Message window shows that the Problem Report file has been successfully generated.

![Message window](image)
13.2 Create an Excel Format Report

RTCA Software offers a convenient way to export individual pages or all the pages to an Excel file. To do so, follow the steps below:

► Select Export Experiment Info from Plate menu
► Select the Page(s) you want to export (the default is export all pages)
► Choose Format for Layout page
► Choose Time points for Cell Index page

If you choose All time points and the total time points are more than 1000, only the first 1000 time points data will be exported.

► Choose to Export As either Excel Sheet or Text Document.
► Click Ok to export the selected experimental data to an Excel file.
14. **RTCA Software Functions Unique To The RTCA MP Instrument**

⚠️ This section is for users of the RTCA MP Instrument only.

It describes the user graphic interfaces for the RTCA MP Instrument and the major differences between RTCA SP and RTCA MP Instruments, followed by a description of functions and operations unique to RTCA MP Instrument. Finally, it gives a detailed example of multiple users running experiments on the RTCA MP Instrument.

14.1 **MP User Graphic Interface**

The MP user graphic interface consists of a Main (parent) Window and six Plate (children) Windows (P1-P6).

Both the Main Window and the six Plate Windows are resizable.

When the Main Window is resized, the six Plate Windows are resized accordingly.

Individual Plate Windows can be resized without affecting.
14.2 The Major Differences of RTCA SP and RTCA MP Instruments

In terms of user interfaces and functions, each Plate Window within the MP Main Window is similar to the SP Window, and contains all individual-plate-dependent functions, such as Start Step / Pause / Continue, Abort, Scan Plate.

The MP Main Window contains the common functions that apply to all six Plate Windows, such as Start All, Pause All, Continue All, Abort All and Scan All, etc. Since the RTCA SP Instrument has only one E-Plate 96, those functions for All plates do not apply to the SP Instrument, and are therefore not shown in the SP main window; in addition, there is no toolbar on the SP main window.

14.3 Overview of Functions and Controls Unique to the RTCA MP Instrument

The RTCA MP Instrument can simultaneously run up to six E-Plate 96 experiments for up to six different users.

Actions taken on each Plate Window are applied to that individual Plate Window only.

For example, clicking the Start button on the P4 Plate Window [#4] will start the experiment on Plate [#4] only.

Actions taken on the main window are applied to all plate windows that are owned by the current login user.

Clicking the Start All button on a Main Window will start experiments on all valid plates.

"Valid Plates" means:

1) The E-Plate 96 is owned by the login user.

2) The E-Plate 96 experiment is ready to be started.
The Table below describes all the functions and controls unique to the RTCA MP Instrument.

<table>
<thead>
<tr>
<th>Controls</th>
<th>Function / Example</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td><strong>Reopen</strong> the most recently opened experiment(s)</td>
<td>Any reserved plate window ignores this command.</td>
</tr>
<tr>
<td></td>
<td><strong>Save</strong> changes for plate window(s)</td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Lock</strong> cradle(s)</td>
<td>A plate window ignores this, if it is already locked.</td>
</tr>
<tr>
<td></td>
<td><strong>Unlock</strong> cradle(s)</td>
<td>A plate window ignores this, if it is already unlocked.</td>
</tr>
<tr>
<td></td>
<td><strong>Start / Continue</strong> experiment(s)</td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Pause</strong> experiment(s)</td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Cancel</strong> pending action(s)</td>
<td>Pending action is an action issued, but that has not yet been executed, because the analyzer is busy with another plate window.</td>
</tr>
<tr>
<td></td>
<td><strong>Abort</strong> current running Step for plate window(s)</td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Scan</strong> plate window(s)</td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Stop Scan</strong> for plate window(s)</td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Restore</strong> all 6 plate windows to fit within the main window, and show the cradle status for each plate window (see next Control Function for an example)</td>
<td>This function does not require the logged-in user to be the owner of the plate windows, or the Administrator. Every login user can do this.</td>
</tr>
</tbody>
</table>

(same function as above)
## RTCA Software Functions Unique To The RTCA MP Instrument

### Overview of Functions and Controls Unique to the RTCA MP Instrument

<table>
<thead>
<tr>
<th>Controls</th>
<th>Function / Example</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1.png" alt="Image" /></td>
<td><strong>Resize</strong> plate window(s) owned by the login user within the main window, and keep current page displayed in plate window(s).</td>
<td>The example shows that the logged-in user is using 6 plate windows, but the 6 plate windows are on different pages. Click &quot;Current Page&quot; under <strong>All</strong> to resize the 6 plate windows so that they fit within the main window, and keep all current pages displayed. If you do not want to show all of the plate windows you are using, you can minimize those plate windows, and then click &quot;Current Page&quot;, to show only the unminimized windows.</td>
</tr>
<tr>
<td><img src="image2.png" alt="Image" /></td>
<td><strong>Show Exp Notes</strong> page(s) for the plate window(s) owned by logged-in user.</td>
<td>Similarly, if you choose one of the other pages (e.g., the Plot page), the respective page is shown in the plate window(s) owned by the logged-in user.</td>
</tr>
<tr>
<td><img src="image3.png" alt="Image" /></td>
<td><strong>Maximize</strong> the individual plate (P1 to P6) window.</td>
<td>After the selected plate window is maximized, the plate window’s current page is not changed.</td>
</tr>
</tbody>
</table>
## 14.4 Launch RTCA MP Software

Double-click the RTCA Software 2.1 icon on the RTCA Control Unit. The RTCA Software will detect hardware connections and enter different operation modes, depending on the connections detected.

> It may take a few minutes for RTCA Software to initialize the RTCA MP Instrument and display.

If no RTCA MP Instrument is connected to the RTCA Control Unit, or the connected RTCA MP Instrument is turned off, the RTCA Software may show a dialog window that allows the user to enter the Offline mode. Alternatively, if the RTCA MP Instrument connected to the RTCA Control Unit is turned on, the RTCA Software will enter the Real-Time mode automatically.

### 14.4.1 RTCA Software in MP Offline Mode

When the RTCA Software enters the MP offline mode, all hardware-related controls, such as Lock / Unlock, Scan Plate, and the Start / Abort Step are disabled. You can however still use the RTCA Software to analyze a previously run experiment, or design experiments for later use.

> Please check Section 4 of this Software Manual for details on designing an experiment template.

### 14.4.2 RTCA Software in MP Real-Time Mode

When the RTCA Software enters the MP Real-Time mode, it automatically performs the Scan Plate function for all E-Plates 96 engaged in the cradles of the RTCA MP Station. This automatic Scan Plate may take up to 40 seconds, depending on the number of engaged E-Plates 96.

> Please check Sections 5.1 and 5.2 of this Software Manual for details regarding the Scan Plate function.

> Please do not work using the RTCA MP Software while it is initializing or performing the automatic Scan Plate.

### Controls

<table>
<thead>
<tr>
<th>Controls</th>
<th>Function / Example</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximize</td>
<td>a plate window and show the assigned page in that window. For example, the following action (click Exp Notes under Exp Notes under ) will maximize Plate 1 window, and show its Exp Notes page.</td>
<td>There are 6 numbered drop-down menus on the main window toolbar. Each controls its corresponding plate window</td>
</tr>
</tbody>
</table>

---

RTCA Software Functions Unique To The RTCA MP Instrument

Launch RTCA MP Software
After Scanning Plates, the RTCA Software is ready for users to start experiments in either of the following ways:

1) Start a new experiment in a Plate Window by:
   - Setting up new Exp Notes (optional), Layout, and Schedule pages or

2) Open an unfinished experiment in a Plate window, and continue it.

Please check Sections 2.4 to 2.6 of this Software Manual to learn how to set up the Exp Notes page.

Please check Section 3 of this Software Manual to learn how to set up Layout page.

Please check Section 4 of this Software Manual to learn how to set up the Schedule page, and for Cloning Individual pages or experiments from either (1) saved templates, or(2) existing experiments.

Please check Sections 4.6 of this Software Manual for details on the Cloning of Experimental Settings.

### 14.5 Example of Multiple Users Running Experiments on the same RTCA MP Instrument

Take for example the case in which three different users are simultaneously running experiments, with two E-Plates 96 each, on the same RTCA MP Instrument. The three users, in this case are: User1, User2, and Administrator.

The sequence for running such experiments can be set up using the following steps:

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>User1, User2, and Administrator each prepare their two respective E-Plates 96 plates. The wells of each E-Plate 96 are filled with cell culture media.</td>
</tr>
<tr>
<td>2</td>
<td>User1 inserts two prepared E-Plates 96 into P1 and P2 cradles, User2 inserts two prepared E-Plates 96 into P3 and P4 cradles. The last two plates for Administrator will in this case be added later.</td>
</tr>
<tr>
<td>3</td>
<td>User1 starts the experiment with their E-Plates 96 on the P1 and P2 cradles.</td>
</tr>
<tr>
<td>4</td>
<td>User1 launches the RTCA Software to enter MP Real-Time mode</td>
</tr>
<tr>
<td>5</td>
<td>User1 Login to the RTCA Software with username User1</td>
</tr>
<tr>
<td>6</td>
<td>User1 maximizes the P1 Plate Window.</td>
</tr>
</tbody>
</table>

Please see Sections 2.4 to 2.6 of this Software Manual for setting up the Exp Notes page.

Please see Section 3 of this Software Manual for setting up Layout page.

Please see Section 4 of this Software Manual for setting up Schedule page.
RTCA Software Functions Unique To The RTCA MP Instrument

Example of Multiple Users Running Experiments on the same RTCA MP Instrument

7. Click on the P1 Plate Window to start an experiment in the E-Plate 96 on cradle 1.
   Cradle 1 will be locked automatically when the experiment starts.

8. Repeat Step 5 to Step 7 for the P2 Plate Window and E-Plate 96 in cradle 2.

9. Remove both the E-Plates 96 from cradle 1 and cradle 2, and then add cells to the appropriate E-Plate Wells.
   Leave both E-Plate 96 in the tissue culture hood for 30 minutes at room temperature, so the cells settle to the bottom of the well, before returning the E-Plates 96 with cells to their cradles.

10. Reinsert the E-Plates 96 to the appropriate positions in cradle 1 and cradle 2, and then have User2 start Step 2 for the next two E-Plates by clicking on Main Window.
    Cradles 1 and 2 will be locked automatically when Step 2 starts.

11. User1 should now logout.

User2 now starts their experiment with E-Plates 96 using the P3 and P4 cradles.

12. User2 performs Login to the RTCA Software with username User2.
    User2 has no rights to the plate windows of User 1, and cannot access either the P1 or P2 Plate Windows.

13. User2 works with P3 Plate Window and P4 Plate Window, following the above steps 5 to step 10 to start experiments with E-Plates 96 on cradle 3 and cradle 4.

    P3 and P4 cradles are locked when User2 starts the experiments.

User1 comes back to perform compound addition to E-Plates at P1 and P2

15. User1 performs login again.

16. User1 clicks Abort All from the Main Window to stop the current step for experiments on the P1 and P2 Plate Windows.
    User1’s action Abort All does not apply to User2’s E-Plates 96 on cradles 3 and 4.

17. User1 clicks Unlock All from the Main Window. The P1 and P2 cradles are unlocked.
    User1’s action Unlock All does not apply to User2’s E-Plates 96 on cradles 3 and 4.

18. User1 now removes the E-Plates 96 from cradle 1 and cradle 2, and adds compounds to the appropriate wells of E-Plates 96.

19. User1 replaces these E-Plates 96 to their correct cradle 1 and 2, respectively. The RTCA Software detects the presence of E-Plates 96 on cradle 1 and 2, and starts an auto-scan of both these E-Plates 96 (on cradle 1 and 2).
    The RTCA Software auto-scans the E-Plates 96 in the order that they were re-inserted into the cradle pockets.

20. User1 starts Step 3 by clicking on Main Window for the two E-Plates.
Example of Multiple Users Running Experiments on the same RTCA MP Instrument

21 User1 performs [logout].

Administrator performs login to the RTCA Software to start their experiment with all the E-Plates 96 on RTCA MP Station, including the two new plates for the P5 and P6 Plate Windows.

22 Administrator inserts two new E-Plates 96 into P5 and P6 cradles respectively.

23 Administrator works with P5 and P6 Plate Windows by carrying out the above Step 5 to Step 9 to start the new experiments for E-Plates on P5 and P6 cradles.

24 Administrator checks the data on the P1, P2 P3 and P4 Plate Windows by plotting the Cell Index curves for the selected wells on the Plot page of each Plate Window.

Administrator has the login rights to access all other Users’ experiments, concurrently running on the RTCA MP Instrument.

25 Administrator performs [logout].

26 Experiments for all six E-Plates on the RTCA MP Station continue and the RTCA Software is ready for either User1, User 2 or Administrator to login.

All six E-Plates 96 are locked, so that no one (other than User1, User2 or Administrator) can accidentally remove an E-Plate 96 without logging onto the RTCA Software.
15. **RTCA Software Functions Unique To The RTCA DP and RTCA TP Instruments**

⚠️ This section is for users of the RTCA DP or RTCA TP Instrument only.

⚠️ All functions below mentioned are both applicable for E-Plate 16 (used with DP and TP Instruments) and CIM-Plate 16 (used with DP instrument).

It describes the connection of RTCA DP or RTCA TP Instrument, followed by a description of user graphic interfaces and all experiment patterns available when using the RTCA DP or RTCA TP Instrument. Finally, it discusses the functions and operations that are unique to the RTCA DP or RTCA TP Instrument.

### 15.1 RTCA DP or RTCA TP Instrument Connection

The RTCA DP or RTCA TP Instrument uses a USB cable to connect to the computer. The USB cable carries out two functions:

► Communicates between the RTCA DP or RTCA TP Analyzer and RTCA Control Unit (with computer and software).
► Provides the power supply for the RTCA DP or RTCA TP Instrument.

There is no extra power supply or power switch on the RTCA DP or RTCA TP Instrument.

### 15.2 DP or TP User Graphic Interface

The DP or TP user graphic interface consists of a **Main Window** and three **Plate Windows**. It is similar to RTCA MP software, except that the number of windows is three, and each plate has 16 (not 96) wells.

Both the Main Window and the three Plate Windows are resizable.

When the Main Window is resized, the three Plate Windows are resized accordingly.

Individual Plate Windows can be resized without affecting other Plate Windows.
The Combination of Using Multiple E-Plates 16 or CIM-Plate 16 Within an Experiment

In terms of user interfaces and functions, each Plate Window within the DP or TP Main Window is similar to the MP Plate Window, and contains all the individual-plate-dependent functions such as Start Step / Pause / Continue, Abort, Scan Plate.

The RTCA DP or RTCA TP Software allows users to combine up to three different E-Plate 16 (used with DP and TP Instruments) and CIM-Plate 16 (used with DP instrument) in a window when running an experiment. The possible combinations are:

- Run three experiments in three windows with each window containing an E-Plate 16.
- Run an experiment in a single window with all three E-Plates 16.
- Run two experiments in two windows, such that window 1 contains E-Plate #1 and #2, and window 2 contains E-Plate #3.
- Run two experiments in two windows, such that window 1 contains E-Plate 16 #1, and window 2 contains E-Plate 16 #2 and E-Plate 16 #3.
- Run two experiments in two windows, such that window 1 contains E-Plate 16 #2, and window 2 contains E-Plate 16 #1 and E-Plate 16 #3.

Although option 5) is available, it is highly recommended not use this experiment pattern. It can create confusion and may lead to a loss of experimental data, if the wrong cradle is inadvertently opened.

The major difference between the RTCA DP or RTCA TP and RTCA SP is that the RTCA DP or RTCA TP has three Plate Windows, while the RTCA SP has only one Plate Window; the major difference between RTCA DP or RTCA TP and RTCA MP is that the E-Plate 16 (used with DP and TP Instruments) and CIM-Plate 16 (used with DP instrument) can be combined within a window in DP or TP, but not in MP.

Please note that the E-Plates 16 can be used with the RTCA DP and RTCA TP Instruments, CIM-Plate 16 can be used with the RTCA DP Instrument, and the E-Plates 96 can be used with the RTCA SP and RTCA MP Instruments.
15.4 Overview of Functions and Controls Unique to the RTCA DP or RTCA TP Instrument

The RTCA DP or RTCA TP Instrument can simultaneously run up to three E-Plate 16 (used with DP and TP Instruments) and CIM-Plate 16 (used with DP instrument) experiments for up to three users.

Actions carried out for each Plate Window are applied to only that individual Plate Window.

For example, clicking the Start button on the D3 or T3 Plate Window [#3] will only start the experiment on the E-Plate [#3].

Actions carried out on the main window are applied to all Plate Windows, but are subject to the rights that are owned by the login user.

Clicking on the Start All button on a Main Window will start experiments on all valid plates (meaning plates for which the logged-in user has rights, see below).

"Valid Plates" means:
1) The E-Plate 16 (used with DP and TP Instruments) and CIM-Plate 16 (used with DP instrument) is owned by the login user.

2) E-Plate 16 (used with DP and TP Instruments) and CIM-Plate 16 (used with DP instrument) experiment is ready to be started.

The Table below describes all the functions and controls unique to the RTCA DP or RTCA TP Instrument.

<table>
<thead>
<tr>
<th>Controls</th>
<th>Function / Example</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Run three experiments in three windows with each window containing an E-Plate 16 (used with DP and TP Instruments) and CIM-Plate 16 (used with DP instrument)" /></td>
<td>Run three experiments in three windows with each window containing an E-Plate 16 (used with DP and TP Instruments) and CIM-Plate 16 (used with DP instrument)</td>
</tr>
<tr>
<td><img src="image" alt="Run one experiment in a single window with all three E-Plate 16 (used with DP and TP Instruments) and CIM-Plate 16 (used with DP instrument)" /></td>
<td>Run one experiment in a single window with all three E-Plate 16 (used with DP and TP Instruments) and CIM-Plate 16 (used with DP instrument)</td>
</tr>
<tr>
<td><img src="image" alt="Run two experiments in two windows, such that window 1 contains E-Plate 16 or CIM-Plate 16 #1 and #2, and window 2 contains E-Plate 16 or CIM-Plate 16 #3" /></td>
<td>Run two experiments in two windows, such that window 1 contains E-Plate 16 or CIM-Plate 16 #1 and #2, and window 2 contains E-Plate 16 or CIM-Plate 16 #3</td>
</tr>
<tr>
<td><img src="image" alt="Run two experiments in two windows, such that window 1 contains E-Plate 16 or CIM-Plate 16 #1, and window 2 contains E-Plate 16 or CIM-Plate 16 #2 and E-Plate 16 or CIM-Plate 16 #3" /></td>
<td>Run two experiments in two windows, such that window 1 contains E-Plate 16 or CIM-Plate 16 #1, and window 2 contains E-Plate 16 or CIM-Plate 16 #2 and E-Plate 16 or CIM-Plate 16 #3</td>
</tr>
<tr>
<td><img src="image" alt="Run two experiments in two windows, such that window 1 contains E-Plate 16 or CIM-Plate 16 #2, and window2 contains E-Plate 16 or CIM-Plate 16 #1 and E-Plate 16 or CIM-Plate 16 #3" /></td>
<td>Run two experiments in two windows, such that window 1 contains E-Plate 16 or CIM-Plate 16 #2, and window2 contains E-Plate 16 or CIM-Plate 16 #1 and E-Plate 16 or CIM-Plate 16 #3</td>
</tr>
<tr>
<td><img src="image" alt="Show all windows" /></td>
<td>Show all windows</td>
</tr>
<tr>
<td><img src="image" alt="Maximize the window containing E-Plate 16 or CIM-Plate 16 #1" /></td>
<td>Maximize the window containing E-Plate 16 or CIM-Plate 16 #1</td>
</tr>
<tr>
<td><img src="image" alt="Maximize the window containing E-Plate 16 or CIM-Plate 16 #2" /></td>
<td>Maximize the window containing E-Plate 16 or CIM-Plate 16 #2</td>
</tr>
<tr>
<td><img src="image" alt="Maximize the window containing E-Plate 16 or CIM-Plate 16 #1 and #2" /></td>
<td>Maximize the window containing E-Plate 16 or CIM-Plate 16 #1 and #2</td>
</tr>
<tr>
<td><img src="image" alt="Maximize the window containing E-Plate 16 or CIM-Plate 16 #1 and #3" /></td>
<td>Maximize the window containing E-Plate 16 or CIM-Plate 16 #1 and #3</td>
</tr>
</tbody>
</table>
15.5 Launch RTCA DP or RTCA TP Software

Double-click the RTCA Software 2.1 icon on the RTCA Control Unit. The RTCA Software will detect hardware connections and enter different operation modes, depending on the connections detected.

It may take a few minutes for the RTCA Software to initialize the RTCA DP or RTCA TP Instrument and display.

If no RTCA DP or RTCA TP Instrument is connected to the RTCA Control Unit, or the connected RTCA DP or RTCA TP Instrument is turned off, the RTCA Software may show a dialog window that allows the user to enter the Offline mode. Alternatively, if the RTCA DP or RTCA TP Instrument connected to the RTCA Control Unit is turned on, the RTCA Software will enter Real-Time mode automatically.

15.5.1 RTCA Software in DP or TP Offline Mode

When RTCA Software enters the DP or TP offline mode, all hardware-related controls such as Scan Plate, and Start / Abort Step are disabled. You can however still use the RTCA Software to analyze a previously run experiment, or design experiments for later use.

Please check Section 4 of this Software Manual for details on designing an experiment template.

15.5.2 RTCA Software in DP or TP Real-Time Mode

When RTCA Software starts, if an RTCA DP or RTCA TP Instrument is detected, the software enters its DP or TP real-time mode. Since there are five different possible experiment patterns, the software shows a dialog window where the user can set up a default pattern to launch the DP or TP software.
Select a desired pattern from the five available options, and then click *Continue* to enter the DP or TP Software user interface.

### 15.5.3 Set up RTCA DP or RTCA TP Software Default Pattern

If you do not want to choose the experiment each time the RTCA DP or RTCA TP Software starts, you can:

- Select a default pattern
- Check "I have learned this feature. Don’t show me this window next time."
- Click *Continue*

The default pattern is set and the above window will not appear when you launch the DP or TP Software next time, and the software enters your chosen pattern directly.

*The experiment pattern can also be changed by using the toolbar buttons:*

If you want to set up another pattern as a default pattern when the DP or TP Software starts, you can use the software system settings from the main window’s menu:

- Choose: **System → Setup**

![System Settings](image)

Then either check Show Options at Startup to recall the pattern options window, or select the default pattern from the DP or TP Default Pattern dropdown list.

### 15.5.4 RTCA DP or RTCA TP Software Auto-Scan at Startup

When the RTCA Software enters the **DP or TP Real-Time** mode, it automatically performs the Scan Plate function for all the E-Plate 16 (used with DP and TP Instruments) and CIM-Plate 16 (used with DP instrument) engaged in the cradles of the RTCA DP or RTCA TP Analyzer. This automatic Scan Plate may take up to 15 seconds, depending on the number of engaged E-Plate 16 (used with DP and TP Instruments) and CIM-Plate 16 (used with DP instrument).

The Scan Plate results will be shown in the **Cell Index** page after the scanning finishes.

*Please check Sections 5.1 and 5.2 of this Software Manual for details of the Scan Plate function.*

*Please do not work with the RTCA DP or RTCA TP Software while it is initializing or performing the automatic Scan Plate.*

After Scanning the Plates, RTCA Software is ready for users to start experiments in either of the following ways:

1) Start a new experiment in a Plate Window by:
Setting up new Exp Notes (optional), Layout, and Schedule pages

2) Open an unfinished experiment in a Plate window and continue it.

Please check Sections 2.4 to 2.6 of this Software Manual to learn how to set up Exp Notes page.

Please check Section 3 of this Software Manual to learn how to set up Layout page.

Please check Section 4 of this Software Manual to learn how to set up Schedule page.

Please check Section 4.6 of this Software Manual to learn how to Clone Experimental Settings, Individual pages or experiments from either (1) saved templates, or (2) existing experiments.

15.6 Example of Multiple Users Running Experiments on the RTCA DP or RTCA TP Instrument

Take for example the case in which three different users are simultaneously running experiments using the RTCA DP or RTCA TP Instrument, with each user running one E-Plate 16. The three users are: User1, User2, and Administrator.

The sequence for running such experiments can be done according to the following steps:

1. User1, User2, and Administrator prepare three separate E-Plates 16.
   - The wells of each E-Plate 16 are filled with cell culture media.

2. User1 inserts the prepared E-Plate 16 into Cradle #1.

3. User1 starts the experiment with their E-Plate 16 on Cradle #1.

4. User1 launches the RTCA Software to enter DP or TP Real-Time mode.

5. User1 performs login to the RTCA Software with username User1.

5. User1 chooses from toolbar to select the separated experiment pattern, i.e., it is possible for the DP or TP Instrument to run three experiments simultaneously. At this time, User1 can use cradle 1, or cradle 2, or cradle 3 to run their experiment. User1 maximizes the Plate 1 Window, and thereby chooses cradle 1.

   **Always select only the number of cradles you need to run an experiment. If you are only running a single E-Plate 16, do not choose the option to occupy all three cradles; selecting more cradles than you are actually going to use, prevents you and others from starting another experiment with unused cradles while this experiment is running.**

6. User1 performs setup for the Exp Notes Page, Layout Page, and Schedule Page
   - Please see Sections 2.4 to 2.6 of this Software manual for setting up Exp Notes page.
   - Please see Section 3 of this Software manual for setting up Layout page.
   - Please see Section 4 of this Software manual for setting up Schedule page.

7. User1 clicks on the D1 or T1 Window to start an experiment in E-Plate 16 on cradle 1.
RTCA Software Functions Unique To The RTCA DP and RTCA TP Instruments

Example of Multiple Users Running Experiments on the RTCA DP or RTCA TP Instrument

8 User1 removes the E-Plate 16 from cradle 1, then adds cells to the E-Plate 16 Wells.  
   Please always leave the E-Plate 16 in the tissue culture hood for 30 minutes at room 
   temperature, so the cells can settle to the bottom of the well before returning the 
   E-Plate 16 with cells to its cradle.

9 User1 reinserts the E-Plate 16 with cells on cradle 1, and starts Step 2 of the experiment 
   by clicking on Main Window.

10 User1 should now logout.

User2 now starts their experiment with E-Plates 16 on cradle 2.

11 User2 performs Login to the RTCA Software with username User2.  
   User2 cannot access the D1 or T1 Window that was used by User1, because only 
   User1 has the rights to D1 or T1 Window.  
   At this time, User2 can run a single Device experiment on either cradle 2 or cradle 
   3. User2 can also run a two E-Plate 16 experiment, since both cradle 2 and cradle 3 
   are available.

12 User2 works with D2 or T2, following the above described Steps 5 to Step 9 to start 
   experiments with E-Plate 16 on only cradle 2.

13 User2 logout.

User1 comes back to perform compound addition to E-Plates 16 on cradle 1.

14 User1 performs login again.

15 User1 clicks Abort All from the Main Window. This aborts the current step for 
   experiments on D1 or T1 Window.  
   User1’s action Abort All does not apply to User2’s E-Plates 16 on cradles 2.  
   Because User1 only has rights to run an experiment on cradle 1, the command Abort 
   All from the Main Window is identical to clicking Abort from the D1 or T1 Window.  
   If User1 had more experiments running, then clicking Abort All from Main Window 
   would have aborted all the running experiments for which User1 had rights.

16 User1 removes E-Plate 16 from cradle 1, and adds compounds to wells of E-Plate 16.  
   Since, in contrast to the RTCA MP Instrument, there is no automatic lock on the 
   RTCA DP or RTCA TP Instrument preventing other users from accidentally removing 
   E-Plates 16, users sharing the RTCA DP or RTCA TP Instrument should always make 
   sure they are opening the correct cradle.

17 User1 reinsert the E-Plate 16 on cradle 1. The RTCA Software detects the presence of 
   the E-Plate 16 on cradle 1, and starts a Scan Plate of E-Plate 16 on cradle 1.  
   When more than one E-Plate 16 is put into the instrument, the RTCA Software 
   automatically scans the E-Plates 16 in the order they were re-inserted into the cradle 
   pockets.

18 User1 starts Step 3 by clicking on the Main Window for the E-Plates 16.

19 User1 performs logout.

Administrator performs login to the RTCA Software to work with all the E-Plates 16 
   on RTCA DP or RTCA TP Instrument, because the Administrator has rights to all three 
   cradles at all times.

20 Administrator can only use cradle 3 to run a single E-Plate 16 experiment, because the 
   other two cradles are already occupied by User1 and User2.  
   Administrator inserts a new E-Plate 16 into cradle 3.
Example of Multiple Users Running Experiments on the RTCA DP or RTCA TP Instrument

21 Administrator works with the D3 or T3 Window and repeats the above described Step 5 to Step 9 to start the experiment for Plate#3.

22 Administrator evaluates the data produced by cells in D1 or T1 Window and D2 or T2 Window by plotting the Cell Index curves for selected wells on the Plot page of each Plate Window.

Administrator has at all times, the rights to access all the other users’ experiments running on the RTCA DP or RTCA TP Instrument.

23 Administrator performs logout.

24 Experiments for all three E-Plates 16 on cradles 1, 2 and 3, of the RTCA DP or RTCA TP Instrument continue running, and the RTCA Software is ready for User1, User2 or Administrator to login.
Appendix

1. Ordering Information

ACEA Biosciences Service and Support

At ACEA, we are committed to providing innovative, high-quality products and excellent customer service. For a complete overview of our products or to find a local representative, please visit www.aceabio.com.

<table>
<thead>
<tr>
<th>Product</th>
<th>Cat. No.</th>
</tr>
</thead>
<tbody>
<tr>
<td>RTCA Analyzer</td>
<td>05228972001</td>
</tr>
<tr>
<td>RTCA SP Station</td>
<td>05229057001</td>
</tr>
<tr>
<td>RTCA MP Station</td>
<td>05331625001</td>
</tr>
<tr>
<td>RTCA Control Unit</td>
<td>05454417001</td>
</tr>
<tr>
<td>RTCA Software Package</td>
<td>05454433001</td>
</tr>
<tr>
<td>RTCA Protector Shield 96</td>
<td>05288967001</td>
</tr>
<tr>
<td>RTCA Resistor Plate 96</td>
<td>05232350001</td>
</tr>
<tr>
<td>RTCA Contact Pins 96 (20 units)</td>
<td>05232384001</td>
</tr>
<tr>
<td>RTCA Frame 96</td>
<td>05232392001</td>
</tr>
<tr>
<td>E-Plate 96</td>
<td>05232368001</td>
</tr>
<tr>
<td>E-Plate 96 (6 units)</td>
<td>05232376001</td>
</tr>
<tr>
<td>RTCA DP Analyzer</td>
<td>05469759001</td>
</tr>
<tr>
<td>RTCA TP Analyzer</td>
<td>05469783001</td>
</tr>
<tr>
<td>RTCA Contact Pins 16 (20 units)</td>
<td>05471575001</td>
</tr>
<tr>
<td>RTCA Resistor Plate 16</td>
<td>05471575001</td>
</tr>
<tr>
<td>E-Plate 16</td>
<td>0546983001</td>
</tr>
<tr>
<td>E-Plate 16 (6 units)</td>
<td>05469813001</td>
</tr>
<tr>
<td>CIM-Plate 16</td>
<td>05665817001</td>
</tr>
<tr>
<td>CIM-Plate 16 Assembly Tool</td>
<td>05665825001</td>
</tr>
<tr>
<td>CIM-Plate 16 Assembly Tool</td>
<td>05665833001</td>
</tr>
<tr>
<td>E-Plate Insert 16</td>
<td>05665832001</td>
</tr>
<tr>
<td>E-Plate Insert 96</td>
<td>06465382001</td>
</tr>
<tr>
<td>E-Plate Insert 96</td>
<td>06465412001</td>
</tr>
<tr>
<td>E-Plate Insert 96</td>
<td>06465455001</td>
</tr>
<tr>
<td>E-Plate Insert 96</td>
<td>06465455001</td>
</tr>
<tr>
<td>E-Plate Insert 96 (6 units)</td>
<td>064654550001</td>
</tr>
</tbody>
</table>

Overview of the RTCA Software